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This is a monthly deep audit. The crawler performed a full-site scan including

Lighthouse performance, axe-core accessibility (WCAG 2.2 AA), cross-browser compatibility,

security headers, schema markup validation, and SEO best-practice checks.

Because this site is not a repository we control, Apex Sentinel **cannot automatically

apply fixes** — instead, each finding below includes an AI-generated plain-English

explanation + step-by-step recommended fix you can hand to a developer or execute

in your CMS directly.

Executive Summary

Overall grade: F

DIMENSION COUNT MEANING

Pages crawled 250 Full sitemap + linked pages

P0 (critical) 1 Site-down or compliance-breaking

P1 (urgent) 6 Significant revenue / SEO / UX impact

https://libertybudsnyc.com/


DIMENSION COUNT MEANING

P2 (high) 103 Quality / ranking / trust degradation

P3 (medium) 852 Polish + optimization

"Do first" items 3 AI-flagged top priorities

Quick wins (< 30 min) 58 Fastest ROI items

Top 10 Actions (Ranked)

If you only have time for ten things this month, do these — in this order.

1. [P0] 🔴  DO FIRST Sensitive artifact exposed: /wp-login.php — _An attacker gaining access to your

WordPress admin account could modify product listings, disable your age-gate, alter compliance

information, inject malicious content, or take your dispensary site offline during peak sales periods._

Page: https://libertybudsnyc.com/wp-login.php

Effort: Quick win (< 30 min)

1. [P1] 🔴  DO FIRST A11y: Elements must only use supported ARIA attributes — _Customers using screen

readers cannot properly navigate your menu, which blocks access to product pages, compliance info, and

age-gate verification—directly reducing traffic from disabled visitors and potentially creating legal

accessibility liability._

Page: https://libertybudsnyc.com/

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST A11y: Links must have discernible text — _This blocks disabled visitors from navigating

your site, exposes you to ADA/WCAG accessibility lawsuits, and reduces organic search ranking because

Google penalizes inaccessible content._

Page: https://libertybudsnyc.com/

Effort: Quick win (< 30 min)

1. [P1] 🟠  HIGH A11y: Elements must meet minimum color contrast ratio thresholds (×2) — _Customers

with visual impairments or using older devices may struggle to read your location options, reducing

navigation ability and potentially losing sales; also exposes you to accessibility compliance complaints._

Page: https://libertybudsnyc.com/

Effort: Quick win (< 30 min)

1. [P1] 🟠  HIGH webkit has 1 JS error(s) not present in Chromium — _Safari users (roughly 25–30% of

mobile traffic) may experience broken functionality, missing ads, or incomplete page loads, directly reducing

conversion rates and ad revenue._

Page: https://libertybudsnyc.com/

Effort: Moderate (1-3 hours)
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1. [P1] Lighthouse bestPractices (desktop): 59/100

Page: https://libertybudsnyc.com/

1. [P1] A11y: ARIA dialog and alertdialog nodes should have an accessible name

Page: https://libertybudsnyc.com/

1. [P2] 🟠  HIGH 14 image(s) missing alt text — _Customers using assistive technology miss out on product

details, which hurts both accessibility compliance and your ability to drive traffic from Google Images—a

major channel for cannabis discovery searches._

Page: https://libertybudsnyc.com/homepage-update/

Effort: Moderate (1-3 hours)

1. [P2] 🟠  HIGH 7 image(s) missing alt text — _Missing alt text reduces SEO ranking for image-driven

searches (product photos, dispensary photos), blocks visually impaired customers from using your site fully,

and signals to Google that your content may be incomplete or low-effort._

Page: https://libertybudsnyc.com/about/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH 9 image(s) missing alt text — _Visitors using screen readers or those on slow connections

can't understand what those images show; search engines can't index the visual content, reducing organic

traffic and compliance with ADA accessibility standards that increasingly affect retail sites._

Page: https://libertybudsnyc.com/cannabis-dispensary-queens-nassau/

Effort: Quick win (< 30 min)

Findings by Severity

P0 — 1 finding

1. Sensitive artifact exposed: /wp-login.php

Severity: P0 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: security

Page URL: https://libertybudsnyc.com/wp-login.php

Rule: tier5.exposed.artifact

What it means (plain English)

Your WordPress login page (/wp-login.php) is publicly accessible and returns a 200 status code, meaning

anyone on the internet can find and attempt to access it. This is a standard WordPress path that attackers

actively scan for and target with automated login attempts. While this is normal WordPress behavior, leaving it

exposed without protection increases your site's vulnerability to brute-force attacks (repeated password

guessing).
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Why it matters for your business: An attacker gaining access to your WordPress admin account could modify

product listings, disable your age-gate, alter compliance information, inject malicious content, or take your

dispensary site offline during peak sales periods.

Technical root cause: WordPress exposes /wp-login.php by default, and your site does not have a Web

Application Firewall (WAF) or server-level rule blocking or rate-limiting access to this path. The login page is

responding normally instead of being hidden, moved, or protected.

Recommended fix — step by step

1. Install Wordfence Security plugin: Go to WordPress Dashboard → Plugins → Add New, search 'Wordfence',

install and activate it.

2. Open Wordfence → Login Security → enable 'Protect wp-login.php', set IP whitelist for your team's

office/home IPs, and configure rate-limiting to 3 failed attempts per 5 minutes.

3. Enable Two-Factor Authentication in Wordfence: Go to Wordfence → Two-Factor Auth → enable for all admin

accounts, choose authenticator app method.

4. Optional: Rename /wp-login.php using Wordfence → Login Security → 'Change login URL' to something like

/secure-access (requires users to know the new path).

5. Test from an outside IP (or use a VPN) to confirm /wp-login.php is now rate-limited or hidden.

6. Ask your hosting provider if they offer a Web Application Firewall (WAF) in your control panel; many

WordPress hosts include Cloudflare or similar — enable the 'Protect Admin' rule.

P1 — 6 findings

1. A11y: Elements must only use supported ARIA attributes

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://libertybudsnyc.com/

Rule: tier9.a11y.aria-allowed-attr

What it means (plain English)

Your website has a navigation menu link that uses ARIA attributes (aria-expanded, aria-controls, aria-haspopup)

that aren't allowed on standard anchor tags. ARIA attributes are special instructions for screen readers; when

you attach them to elements that don't support them, screen readers become confused and may not announce

the menu correctly to people with visual disabilities.

Why it matters for your business: Customers using screen readers cannot properly navigate your menu, which

blocks access to product pages, compliance info, and age-gate verification—directly reducing traffic from

disabled visitors and potentially creating legal accessibility liability.

Technical root cause: The Elementor page builder (WordPress plugin) is auto-generating ARIA attributes on

anchor tags without checking role compatibility. The <a>  tag does not have a recognized role that supports

aria-expanded, which is only valid on elements with roles like 'button', 'menuitem', or 'tab'.

Recommended fix — step by step

1. Log in to WordPress admin → Plugins → search 'Elementor' and verify you're on the latest version; update if

available.
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2. Go to WordPress admin → Pages/Posts using Elementor → edit the homepage (or affected page) with

Elementor visual builder.

3. Find the navigation menu element → click it → look for a 'Mobile Menu' or 'Hamburger' toggle in the left

panel.

4. In the advanced settings (usually a gear icon), search for or disable any 'Accessibility' or 'ARIA' auto-

generation options if present.

5. As a workaround: switch the menu to use a native WordPress menu (Appearance → Menus) instead of

Elementor's built-in menu, then re-add it via a menu widget.

6. Test with a free screen reader (NVDA for Windows, VoiceOver on Mac) to confirm the menu announces

correctly.

7. If the issue persists, contact Elementor support or file a bug report; this is a known Elementor quirk in some

versions.

2. A11y: Links must have discernible text

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://libertybudsnyc.com/

Rule: tier9.a11y.link-name

What it means (plain English)

A link on your homepage has no visible or hidden text label. Screen readers—software that reads pages aloud

for blind and low-vision visitors—cannot announce what the link does. In this case, it's a next-slide button in an

image carousel. Without a label, users relying on screen readers have no way to know where the link goes or

what it controls.

Why it matters for your business: This blocks disabled visitors from navigating your site, exposes you to

ADA/WCAG accessibility lawsuits, and reduces organic search ranking because Google penalizes inaccessible

content.

Technical root cause: The link element contains only an icon or image with no alt text, aria-label, or title

attribute. Elementor's lightbox carousel feature did not auto-generate accessible text for the navigation button.

Recommended fix — step by step

1. Log in to WordPress admin → Pages → edit the homepage (or the page containing the carousel).

2. In the Elementor editor, click the carousel widget to select it.

3. Click the 'Advanced' tab in the left panel and scroll to the 'Accessibility' section.

4. In the 'ARIA Label' field, enter descriptive text for the next-slide button (e.g., 'Next slide').

5. Alternatively, if no Accessibility section exists, click the arrow/button element itself and add an 'aria-label'

attribute via the HTML widget or custom CSS in the Advanced tab.

6. Save and publish. Test with a screen reader (use NVDA for Windows or VoiceOver on Mac) to confirm the

button label is announced.

3. A11y: Elements must meet minimum color contrast ratio thresholds (×2)

Severity: P1 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)
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Business category: accessibility

Page URL: https://libertybudsnyc.com/

Rule: tier9.a11y.color-contrast

What it means (plain English)

Two location-name buttons on your homepage have black text (#000000) on a dark green background

(#347c3c), creating a contrast ratio of 4.09:1. WCAG accessibility standards require at least 4.5:1 contrast for

text this size to be readable by people with low vision or color blindness. This affects your 'Manhattan/Roosevelt

Island' and 'Queens/Nassau' location buttons.

Why it matters for your business: Customers with visual impairments or using older devices may struggle to

read your location options, reducing navigation ability and potentially losing sales; also exposes you to

accessibility compliance complaints.

Technical root cause: The button styling uses inline CSS (style=) that pairs #000000 text with #347c3c

background. The dark green is too close in lightness to black, failing the contrast math (4.09 ÷ 4.5 required).

Recommended fix — step by step

1. In WordPress admin, go to Appearance → Customize → Colors (or your active theme's color panel) and look

for button or accent color settings; temporarily note the current green (#347c3c).

2. Change either the text color to white (#ffffff) or lighten the background to #5a9e5f or brighter; white text on

#347c3c achieves ~7:1 contrast (safe).

3. If using a page builder (Elementor, Divi, etc.), select the location buttons → edit the text color property

directly to #ffffff or edit the button background to a lighter shade.

4. If the styling is hardcoded in your theme, use Appearance → Additional CSS to add: .baag3-card-name
{ color: #ffffff !important; }  to override inline styles.

5. Test the fix with a free online contrast checker (WebAIM Contrast Checker) to confirm 4.5:1 or higher.

6. Re-run your accessibility audit tool to verify both buttons now pass.

4. webkit has 1 JS error(s) not present in Chromium

Severity: P1 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: revenue

Page URL: https://libertybudsnyc.com/

Rule: tier11.browser.webkit-js-errors

What it means (plain English)

Your site is attempting to load a third-party frame (i.liadm.com) in a way that violates browser security rules in

Safari and other WebKit browsers. This frame is blocked because the origin (the combination of protocol,

domain, and port) doesn't match what the parent page expects. The frame loads fine in Chrome because

Chrome's security model is slightly more permissive in edge cases, but Safari enforces it strictly.

Why it matters for your business: Safari users (roughly 25–30% of mobile traffic) may experience broken

functionality, missing ads, or incomplete page loads, directly reducing conversion rates and ad revenue.

Technical root cause: A third-party script (likely an ad network or tracking pixel from i.liadm.com) is being

loaded with incorrect cross-origin attributes or headers. The frame likely lacks proper CORS headers (Cross-

Origin Resource Sharing) or the embedding code uses an insecure protocol or mismatched domain.

Recommended fix — step by step

https://libertybudsnyc.com/
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1. Identify which plugin or embed is loading i.liadm.com: search your WordPress admin → Plugins for ad

networks, analytics, or consent managers (e.g., Consent Management Platform, ad server plugins). Check

Settings → General and any custom code sections.

2. If it's an ad network or affiliate script: contact the vendor (likely Liapps or similar) and request updated

embed code that includes proper CORS headers and uses HTTPS-only.

3. If you manage the embed code directly: edit the iframe or script tag in WordPress → Appearance → Theme

File Editor (or child theme custom code) to add crossorigin='anonymous' attribute and ensure the src uses

https:// protocol.

4. Test in Safari on both desktop and mobile after the fix: open https://libertybudsnyc.com/ in Safari, open

Developer Console (Cmd+Option+I), and verify no origin errors appear in the console.

5. If the vendor cannot provide a fix: consider removing or replacing the i.liadm.com embed with an alternative

service that supports WebKit properly, or request a native WordPress plugin alternative.

5. Lighthouse bestPractices (desktop): 59/100

Severity: P1

Page URL: https://libertybudsnyc.com/

Rule: tier8.lighthouse.bestPractices-desktop

Detail

Score 59 is below target 90. See HTML report for details.

6. A11y: ARIA dialog and alertdialog nodes should have an accessible name

Severity: P1

Page URL: https://libertybudsnyc.com/

Rule: tier9.a11y.aria-dialog-name

Detail

Ensure every ARIA dialog and alertdialog node has an accessible name

Impact: serious

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/aria-dialog-name?application=playwright

P2 — 103 findings

1. 14 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://libertybudsnyc.com/homepage-update/

Rule: tier2.a11y.img-missing-alt
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https://libertybudsnyc.com/
https://libertybudsnyc.com/
https://dequeuniversity.com/rules/axe/4.11/aria-dialog-name?application=playwright
https://libertybudsnyc.com/homepage-update/


What it means (plain English)

Your homepage update page has 14 images without alt text — short descriptions that screen readers read aloud

to blind and low-vision visitors. This means those visitors can't understand what your product photos, strain

guides, or promotional graphics show. It also signals to Google that your images aren't properly labeled, which

reduces your chances of ranking in image search results.

Why it matters for your business: Customers using assistive technology miss out on product details, which

hurts both accessibility compliance and your ability to drive traffic from Google Images—a major channel for

cannabis discovery searches.

Technical root cause: Images were uploaded to WordPress without filling in the 'Alt Text' field during the media

upload or post editing process, or existing images lack the alt attribute in the HTML.

Recommended fix — step by step

1. Log in to WordPress Admin → click on the page 'Homepage Update' → scroll to each image and click it to

open the image editing panel

2. In the right sidebar under 'Image Details,' locate the 'Alt Text' field and enter a short, descriptive phrase

(e.g., 'Sunset Haze flower in glass jar' or 'Liberty Buds storefront on 5th Avenue')

3. Write alt text that describes what the image shows and why it matters (mention strain name, product type,

or context) — aim for 5–12 words per image

4. After filling in alt text for all 14 images, click 'Update' to save the page

5. Install the free plugin 'WP Accessibility' or 'Accessibility Checker' to audit any remaining untagged images

on other pages

6. Add alt text to the remaining 10 properly-labeled images if any are missing descriptions, then spot-check

your Products and Strains archive pages using the same method

2. 7 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://libertybudsnyc.com/about/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Seven images on your About page lack alternative text (alt text)—short descriptions that screen readers

announce to visitors with visual impairments, and that search engines use to understand image content. This

prevents both disabled visitors and search crawlers from knowing what those images show.

Why it matters for your business: Missing alt text reduces SEO ranking for image-driven searches (product

photos, dispensary photos), blocks visually impaired customers from using your site fully, and signals to Google

that your content may be incomplete or low-effort.

Technical root cause: Images were likely uploaded to WordPress without filling in the Alt Text field in the Media

Library, or were embedded in page builders without the alt field being populated during insertion.

Recommended fix — step by step

1. Log in to WordPress admin → go to Pages → Edit the About page

2. For each image, click it and look for the Alt Text field in the inspector panel (often on the right sidebar; if

using a page builder like Elementor or Gutenberg, alt is in the image settings modal)
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3. Write 5–10 word descriptions for each image: e.g., 'Liberty Buds storefront on 5th Avenue' or 'Team member

Sarah at checkout counter'

4. Focus on describing what's visible and relevant to your business (staff, products, location, compliance

signage) rather than generic placeholder text

5. Save/Update the page, then run a re-crawl via Screaming Frog or your SEO tool to confirm alt text now

appears

6. Set a WordPress editorial reminder: before publishing any post/page, search the Media Library for images

without alt text (filter by Alt Text field) and fill them in before hitting Publish

3. 9 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://libertybudsnyc.com/cannabis-dispensary-queens-nassau/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Nine images on your Queens/Nassau dispensary page don't have descriptive alt text — text that appears if the

image fails to load and that screen readers read aloud to visually impaired visitors. This makes the page less

accessible and less visible to search engines, which can't 'see' images without that description.

Why it matters for your business: Visitors using screen readers or those on slow connections can't

understand what those images show; search engines can't index the visual content, reducing organic traffic and

compliance with ADA accessibility standards that increasingly affect retail sites.

Technical root cause: Images were likely inserted into the WordPress page without the alt text field being

populated in the image uploader, or they were added via HTML without alt attributes.

Recommended fix — step by step

1. Log into WordPress admin → go to Pages → edit the Queens/Nassau dispensary page

2. In the block editor, click each image block and look for the 'Alt text' field in the right sidebar (under 'Image

settings')

3. Write a short, descriptive alt text for each: e.g., 'Liberty Buds storefront on Queens Boulevard' or 'Cannabis

product shelf display' — be specific but concise (under 125 characters)

4. For product images, include strain name or product type: 'Sativa flower package labeled Sour Diesel'

5. After updating all 9 images, click 'Update' to save the page

6. Use a free browser extension like WAVE or axe DevTools to re-scan the page and confirm all images now

have alt text

4. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/category/wellness/

Rule: tier2.meta.no-description

What it means (plain English)
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Your wellness category page doesn't have a meta description — the 155-character summary that appears under

your page title in Google search results. Without it, Google may auto-generate something generic or

incomplete, which reduces click-through rates from search results.

Why it matters for your business: Customers searching for wellness products won't see a compelling preview

of your category, leading to fewer clicks and lower search traffic to that section.

Technical root cause: WordPress category pages often inherit default (empty) meta descriptions from theme

settings. You likely haven't customized this field for the wellness category archive.

Recommended fix — step by step

1. Log into WordPress admin → Posts → Categories

2. Click 'Wellness' to edit the category

3. Scroll to the SEO section (usually provided by Yoast SEO or Rank Math plugin; if not installed, install one

now)

4. In the 'Meta description' field, write 150–160 characters: e.g., 'Explore our wellness collection: premium CBD

oils, tinctures & topicals. Lab-tested, potency-verified. Shop Liberty Buds NYC.'

5. Click 'Update' to save

6. Repeat for other high-traffic category pages (edibles, flower, concentrates, etc.)

5. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/category/education/

Rule: tier2.meta.no-description

What it means (plain English)

Your /category/education/ page is missing a meta description — the 155-character summary that appears under

your page title in Google search results. Without it, Google may auto-generate one from your page text, which

often looks choppy or fails to tell visitors why they should click.

Why it matters for your business: Missing descriptions reduce click-through rates from search results,

meaning fewer visitors discover your educational content and product pages, directly impacting traffic and

potential customer acquisition.

Technical root cause: WordPress category archives do not automatically populate the meta description field

unless explicitly set. The theme or SEO plugin is not generating fallback descriptions for taxonomy pages.

Recommended fix — step by step

1. Install or open Yoast SEO (free version) if not already active: Dashboard → Plugins → Search for 'Yoast SEO'

→ Install & Activate.

2. Navigate to Posts → Categories in WordPress admin.

3. Click 'education' to edit the category.

4. Scroll to the Yoast SEO box at the bottom of the page.

5. In the 'SEO title & meta description' section, click the meta description field and write a 150–160 character

description, e.g., 'Learn about cannabis education, strains, effects, and safe consumption methods at

Liberty Buds NYC.'

6. Click 'Update' to save.
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7. Repeat this process for all other category pages (e.g., /category/news/, /category/promotions/, etc.).

6. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/category/product-reviews/

Rule: tier2.meta.no-description

What it means (plain English)

Your product reviews category page doesn't have a meta description—the 155-character summary that appears

below your page title in Google search results. Without it, Google generates a random snippet from your page

content, which often looks unprofessional and fails to encourage clicks.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

meaning fewer customers discover your product reviews and cannabis offerings, directly costing you foot

traffic.

Technical root cause: WordPress category pages don't automatically generate meta descriptions. The

template or SEO plugin hasn't been configured to add one to this archive page.

Recommended fix — step by step

1. Log into WordPress admin → go to Posts → Categories

2. Find and click 'Product Reviews' category

3. Scroll to the SEO section (if using Yoast SEO, it appears below the editor; if using Rank Math, click the 'SEO'

tab)

4. Enter a meta description under 160 characters, e.g.: 'Read honest customer reviews of premium cannabis

strains, edibles, and products at Liberty Buds NYC.'

5. Click 'Update' or 'Save' to apply the change

6. Repeat this process for other category pages showing the same issue

7. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/category/liberty-buds/

Rule: tier2.meta.no-description

What it means (plain English)

Your category archive page (Liberty Buds news/blog section) is missing a meta description—the 160-character

summary that appears under your site name in Google search results. Without it, Google generates a random

snippet from your page content, which often looks incomplete or irrelevant to searchers.

Why it matters for your business: Missing descriptions reduce click-through rate from search results;

potential customers see a confusing preview and choose a competitor's listing instead.

Technical root cause: WordPress category pages often inherit a blank or default meta description from theme

settings, especially if a category-specific description was never filled in.
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Recommended fix — step by step

1. Log into WordPress admin → Posts → Categories

2. Click 'Liberty Buds' category → scroll to the description field

3. Enter a 155–160 character description (e.g., 'Latest news, updates, and community stories from Liberty

Buds NYC dispensary.')

4. If using Yoast SEO, open the category and fill the 'SEO title' and 'Meta description' fields in the sidebar

5. If using Rank Math, go to the category, click the 'Rank Math' tab, and fill 'Meta Description'

6. Save and wait 48 hours for Google to recrawl; check Google Search Console → Pages to verify the new

snippet appears

8. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/upper-east-side/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'upper-east-side' is missing a meta description — the 160-character text snippet that appears

under your link in Google search results. Without it, Google generates a random excerpt from the page, which

often looks unprofessional and doesn't tell customers what to expect.

Why it matters for your business: Missing descriptions reduce click-through rates from search results;

customers see unclear or irrelevant text and pick a competitor's link instead, directly hurting foot traffic and

online orders.

Technical root cause: WordPress tag pages use default templates that don't auto-generate descriptions. The

theme or a plugin (like Yoast SEO) must be configured to create descriptions for tag archives, or they must be

added manually.

Recommended fix — step by step

1. Install Yoast SEO (if not already active): go to Plugins → Add New, search 'Yoast SEO', install and activate.

2. In WordPress admin, go to Yoast SEO → Search Appearance → Taxonomies tab.

3. Find the 'Tags' row and toggle 'Show in search results' to ON.

4. In the same row, locate the meta description template field and set it to something like: '%%term_title%%

cannabis products in NYC | Liberty Buds – Premium selections near you.'

5. Save changes. Go to Posts → Tags in WordPress admin, click the 'upper-east-side' tag, and scroll to the

Yoast SEO box at the bottom. Enter a unique 155–160 character description (e.g., 'Explore premium

cannabis, edibles, and flower near Upper East Side, Manhattan. Same-day delivery available.').

6. Repeat for other high-traffic tags (e.g., 'brooklyn', 'astoria', 'murray-hill').

9. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/dispensary-culture/

https://libertybudsnyc.com/tag/upper-east-side/
https://libertybudsnyc.com/tag/dispensary-culture/


Rule: tier2.meta.no-description

What it means (plain English)

Search engines like Google use meta descriptions—a 155-character summary of a page—to decide what text

appears under your link in search results. Without one, Google generates its own from page content, which

often looks messy and fails to convince people to click. This tag page has no description, so potential

customers see an auto-generated snippet instead of your marketing message.

Why it matters for your business: Missing meta descriptions reduce click-through rate from search results,

directly lowering foot traffic to your dispensary's website and cutting into local cannabis sales.

Technical root cause: WordPress doesn't auto-generate meta descriptions by default. The Yoast SEO or Rank

Math plugin (if installed) can do this, but either it's not active, or this tag page wasn't assigned a description in

the plugin settings.

Recommended fix — step by step

1. Log into WordPress admin → Plugins. Verify Yoast SEO or Rank Math is installed and activated; if not, click

'Add New', search 'Yoast SEO', install and activate it.

2. Go to Posts → Tags, find 'dispensary-culture', click Edit.

3. Scroll to the SEO section (Yoast) or the plugin's metabox. In the meta description field, write a 155-

character description. Example: 'Explore dispensary culture, cannabis education, and community events at

Liberty Buds NYC. Stay informed on industry trends and local cannabis news.'

4. Click Save and verify the description appears in search results within 1-2 weeks by searching 'Liberty Buds

dispensary culture' on Google.

10. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-lifestyle/

Rule: tier2.meta.no-description

What it means (plain English)

This page doesn't have a meta description—the 155-character summary that appears below your page title in

Google search results. Without it, Google generates one automatically, which is often choppy or irrelevant. For a

tag page like /tag/cannabis-lifestyle/, this means potential customers won't see a compelling reason to click

through from search.

Why it matters for your business: Missing meta descriptions reduce click-through rate from search results,

directly lowering traffic to category pages that could drive product discovery and sales.

Technical root cause: WordPress tag pages don't auto-generate meta descriptions by default, and this tag

likely wasn't manually configured in an SEO plugin or theme settings.

Recommended fix — step by step

1. Install or verify Yoast SEO is active (Dashboard → Plugins → search 'Yoast SEO'); if absent, install it.

2. Go to Dashboard → Posts → Tags, click the 'cannabis-lifestyle' tag.

3. Scroll to the Yoast SEO meta box below the editor and enter a description like: 'Explore cannabis lifestyle

trends, wellness tips, and community stories from Liberty Buds NYC.'

4. Ensure the description is 150–160 characters so it displays fully in Google.

https://libertybudsnyc.com/tag/cannabis-lifestyle/


5. Click 'Update' to save.

6. Repeat for any other tag pages with missing descriptions (check Dashboard → Posts → Tags for ones

without Yoast meta descriptions).

11. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/manhattan-weed/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag archive page for 'manhattan-weed' doesn't have a meta description—the 150-160 character summary

that appears under your site name in Google search results. Without it, Google generates a random snippet

from your page, which often looks unprofessional and doesn't encourage clicks.

Why it matters for your business: Lower click-through rates from search results mean fewer visitors

discovering your dispensary, especially for location-based searches where people are actively looking to buy.

Technical root cause: WordPress tag pages typically don't auto-generate meta descriptions. The Yoast SEO or

Rank Math plugin needs to be configured to create them, or they need to be manually added via a plugin

setting.

Recommended fix — step by step

1. Log into WordPress admin → Plugins → search for 'Yoast SEO' or 'Rank Math' (check which one is already

installed).

2. If using Yoast SEO: Go to SEO → Search Appearance → Archives. Find 'Tag archives' and enable 'Show in

search results' if off; set a template like 'Manhattan cannabis products - Shop %%title%% at Liberty Buds

NYC'.

3. If using Rank Math: Go to Rank Math → Titles & Meta → Archives. Find 'Tag' and enable; set a dynamic

template with %%title%% and your location.

4. If neither plugin is installed, install Yoast SEO (free version is sufficient) and repeat step 2.

5. Visit https://libertybudsnyc.com/tag/manhattan-weed/ and verify the meta description now appears when

you view page source or use a SEO inspector tool.

6. Repeat this template for other tag archives (e.g., /tag/dispensary-near-me/, /tag/thc-products/).

12. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-bbq/

Rule: tier2.meta.no-description

What it means (plain English)

Meta descriptions are the short text summaries that appear below your page title in Google search results. This

tag/archive page is missing that summary, so search results will show auto-generated text that may not be

compelling or accurate. This hurts click-through rates from organic search.

https://libertybudsnyc.com/tag/manhattan-weed/
https://libertybudsnyc.com/tag/manhattan-weed/
https://libertybudsnyc.com/tag/cannabis-bbq/


Why it matters for your business: Without a clear, keyword-relevant description on this cannabis-related tag

page, fewer potential customers will click through from Google Search, reducing organic traffic to your content

hub.

Technical root cause: WordPress archive pages (including tag pages) often lack auto-generated meta

descriptions. The site likely has no global rule or plugin setting to populate descriptions for tag archives, leaving

them blank.

Recommended fix — step by step

1. Install the Yoast SEO plugin (free version) if not already active: wp-admin → Plugins → Add New → search

'Yoast SEO' → Install and Activate.

2. Go to Yoast SEO → Search Appearance → Archives and toggle ON the 'Show date archives' and 'Show tag

archives' settings.

3. For tag archives specifically, navigate to Posts → Tags, click 'cannabis-bbq', and add a 60-character meta

description in the Yoast box (e.g., 'Explore cannabis BBQ tips, recipes, and strain pairings from Liberty Buds

NYC.').

4. Repeat for other high-traffic tag pages (check Google Search Console → Performance to identify which tags

get impressions).

5. Use Yoast's Readability/SEO light to ensure descriptions include relevant keywords and stay under 160

characters.

13. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/museum-mile/

Rule: tier2.meta.no-description

What it means (plain English)

Search engines use meta descriptions (the 50–160 character summary under your page title in Google results)

to help people decide whether to click your link. When a page lacks one, Google generates a random snippet

from your content, which often looks unprofessional and may miss key selling points. This tag page about

'museum-mile' currently has no custom description.

Why it matters for your business: Missing descriptions reduce click-through rates from search results;

potential customers see auto-generated text instead of your messaging, hurting traffic and conversions for tag-

based content pages.

Technical root cause: WordPress tag archives are not automatically assigned meta descriptions by default. The

theme or an SEO plugin must explicitly populate the description field for each tag.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: Dashboard → Plugins → Add New → search 'Yoast SEO'

→ Install & Activate.

2. Navigate to Posts → Tags in WordPress admin.

3. Click 'museum-mile' to open the tag editor.

4. Scroll down to the Yoast SEO meta box and enter a description: 'Explore cannabis products & dispensary

news related to Museum Mile. Liberty Buds NYC offers premium selection near Central Park.' (aim for 50–

160 characters).

https://libertybudsnyc.com/tag/museum-mile/


5. Repeat this process for all other tag pages showing no description (run a site audit in Yoast to identify

them).

6. Alternatively, enable the 'Use tag/category archive meta description' setting in Yoast SEO → Titles & Metas

→ Taxonomies → Tags, and set a template (e.g., 'cannabis products tagged: %%term_title%% | Liberty Buds

NYC').

14. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cinco-de-mayo/

Rule: tier2.meta.no-description

What it means (plain English)

This page has no meta description — the 160-character text that appears below your page title in search

results. Without it, Google shows a random snippet from your page content, which is often poorly formatted or

irrelevant. For a cannabis retail site, this means potential customers may not understand what the page offers

before clicking.

Why it matters for your business: Lower click-through rates from search results on tag pages, reducing foot

traffic and online orders from customers searching for seasonal or themed products.

Technical root cause: WordPress is not automatically generating meta descriptions for tag archive pages. By

default, WordPress often leaves these blank unless explicitly filled in via an SEO plugin or theme setting.

Recommended fix — step by step

1. Install or activate Yoast SEO plugin (if not already active): Dashboard → Plugins → Search for 'Yoast SEO' →

Install & Activate

2. Go to the tag page in WordPress: Dashboard → Posts → Tags → Click 'Cinco de Mayo' tag

3. Scroll to the Yoast SEO metabox at the bottom and enter a unique description like: 'Celebrate Cinco de Mayo

with Liberty Buds NYC — explore our curated selection of cannabis products and limited-time offers.'

4. Ensure the description is 150–160 characters and includes the tag name + a benefit statement

5. Click 'Update' to save

6. Repeat for other high-traffic tag pages (check Search Console to identify which tag pages get the most

impressions)

7. Optional: Use Yoast's 'Tag settings' bulk feature (Yoast → Search Appearance → Archives → Tags) to set a

default template for all tag descriptions

15. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-party-ideas/

Rule: tier2.meta.no-description

What it means (plain English)

https://libertybudsnyc.com/tag/cinco-de-mayo/
https://libertybudsnyc.com/tag/cannabis-party-ideas/


This tag archive page is missing a meta description—a short text summary that appears below your page title in

search results. Without it, search engines show a random snippet from your page, making it less likely people

click through.

Why it matters for your business: Lower click-through rates from Google search results for cannabis-related

queries, directly reducing foot traffic and online inquiries to your dispensary.

Technical root cause: WordPress archive pages (tags, categories) often lack auto-generated meta

descriptions. Most sites only add descriptions to individual product or blog posts, leaving taxonomy pages

unoptimized.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: go to Plugins > Add New, search 'Yoast SEO', install and

activate.

2. Navigate to Yoast SEO > General Settings > Features and ensure 'Meta descriptions' toggle is ON.

3. Go to Posts > Tags, find the 'cannabis-party-ideas' tag, edit it, and add a 70–160 character description in

the Yoast meta description field below the tag name (e.g., 'Discover cannabis-friendly party ideas and tips

from Liberty Buds NYC. Shop premium flower and concentrates for your next event.').

4. Repeat for all other tag archive pages: Posts > Tags, click each tag, add a unique meta description.

5. Go to Yoast SEO > Tools > Bulk Editor to view all tags at once and batch-add descriptions for faster

workflow.

6. After updating, go to Google Search Console > Coverage and request indexing of the tag page to speed up

re-crawl.

16. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/thc-beverages/

Rule: tier2.meta.no-description

What it means (plain English)

This tag page (/tag/thc-beverages/) has no meta description — the 155-character summary that appears below

your site title in Google search results. When Google can't find one, it generates a random snippet from page

text, which often looks unprofessional and misses keywords customers are searching for.

Why it matters for your business: Potential customers searching for "THC beverages" in your area see a poor

or irrelevant preview in search results, reducing click-through rate and losing traffic to competitors with

optimized listings.

Technical root cause: WordPress tag pages typically inherit or auto-generate meta descriptions; this tag page

either has an empty description field or is using a theme/plugin default that produces nothing.

Recommended fix — step by step

1. Log into WordPress admin → Tags → click 'THC Beverages' to edit the tag

2. Scroll down and locate the meta description field (usually in the Yoast SEO or All in One SEO plugin box; if

not visible, install Yoast SEO plugin first)

3. Enter a 150–160 character description: 'Shop premium THC beverages at Liberty Buds NYC. Craft drinks,

edibles & refreshments. Licensed dispensary in NYC. Order online or visit us today.'

4. Click 'Update' to save

https://libertybudsnyc.com/tag/thc-beverages/


5. Repeat for other tag pages (filter by those missing descriptions in WordPress → Tags admin list)

6. Optional: Enable Yoast's bulk edit feature (Yoast SEO → Tools → Bulk Editor) to add descriptions to multiple

tags at once

17. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-edibles/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'cannabis-edibles' is missing a meta description — the 50–160 character summary that

appears below your page title in Google search results. Without it, search engines write their own summary,

which may not highlight what makes your edibles selection special or compelling to customers looking for

products.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

meaning fewer potential customers visit your edibles category even if you rank well.

Technical root cause: WordPress does not auto-generate meta descriptions for tag archive pages by default.

An SEO plugin (like Yoast SEO or Rank Math) is either not installed or not configured to create descriptions for

tag pages.

Recommended fix — step by step

1. Install Yoast SEO (free version) from WordPress admin → Plugins → Add New, search 'Yoast SEO', click

Install Now.

2. After activation, go to Yoast SEO → Dashboard → General settings → Title & Meta. Enable 'Show

metadescription in search results'.

3. Navigate to Posts → Tags, click 'cannabis-edibles' tag, scroll to the Yoast SEO box at bottom, and write a

unique 155-character description (e.g., 'Explore Liberty Buds' premium cannabis edibles in NYC. Browse

gummies, chocolates, & infused treats with tested potency & fast delivery.').

4. Click Update, then open Google Search Console (if you have access) and request a re-index of that tag page

URL.

5. Repeat step 3 for other high-traffic tag pages (cannabis-flower, cannabis-concentrates, etc.).

18. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/thc-label-guide/

Rule: tier2.meta.no-description

What it means (plain English)

This page has no meta description—the 155-character summary that appears below your page title in Google

search results. Without one, Google generates a random excerpt from your page, which often looks

unprofessional and may not mention your most important keywords like 'THC labeling' or 'cannabis education.'

https://libertybudsnyc.com/tag/cannabis-edibles/
https://libertybudsnyc.com/tag/thc-label-guide/


Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

meaning fewer visitors discover your educational content about THC labeling—a key trust and compliance signal

for your dispensary.

Technical root cause: The tag page template in your WordPress theme does not include a meta description

field, or the field was left blank during setup. This is common on auto-generated archive pages like tag and

category pages.

Recommended fix — step by step

1. Log in to WordPress admin → Pages/Posts → find the page edit screen for the THC label guide tag page (or

go directly to /tag/thc-label-guide and check 'Edit Page')

2. Look for an 'SEO' or 'Meta' section (usually added by Yoast SEO, Rank Math, or All in One SEO if installed); if

not visible, activate one of these plugins via Plugins → Add New

3. In the meta description field, write a 150–160 character summary: 'Learn THC labeling requirements for NYC

cannabis products. Compliance guide for dispensaries and consumers on cannabinoid testing and warnings.'

4. Save/update the page

5. Repeat for other tag pages (/tag/compliance/, /tag/cannabis-education/, etc.) to prevent this across your

archive pages

6. Optional: install Yoast SEO (free) → Settings → Titles and Metas → enable 'Force rewrite titles and metas' to

auto-enforce descriptions on new tags

19. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/thcv/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'thcv' doesn't have a meta description—a 160-character summary that appears in Google

search results below the page title. Without it, Google generates a random snippet from your page content,

which often looks unprofessional and doesn't encourage clicks.

Why it matters for your business: Customers searching for THCV products see a poorly formatted or

irrelevant preview in search results, reducing click-through rate and foot traffic to that category page.

Technical root cause: WordPress tag archives don't automatically populate meta descriptions. The tag page

template is missing either manual description entry or a plugin rule to auto-generate descriptions for taxonomy

pages.

Recommended fix — step by step

1. Install Yoast SEO plugin (if not already active) via WordPress Admin → Plugins → Add New, search 'Yoast',

click Install + Activate.

2. Go to WordPress Admin → SEO (Yoast) → Titles & Metas → Taxonomies → Tags.

3. Enable 'Show date in snippet preview' toggle if desired, then set the meta description template to something

like: 'Shop %%term%% products at Liberty Buds NYC. Browse our selection of %%term%% strains and

edibles online.'

4. Navigate to Posts → Tags → find 'thcv' tag → scroll to Yoast SEO box → manually enter a custom meta

description if the template doesn't fit: e.g., 'THCV products at Liberty Buds NYC – premium strains, edibles

https://libertybudsnyc.com/tag/thcv/


& more. Order online today.'

5. Save and refresh the tag page in an incognito window to verify the description appears in the preview.

20. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cdc/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag archive page for 'cdc' has no meta description — the short text that appears below your site name in

Google search results. Without it, Google may auto-generate one from your page content, which is often less

compelling and may not include your key selling points.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers may choose a competitor's listing instead, directly hurting foot traffic and online orders.

Technical root cause: WordPress tag archive pages typically don't inherit or auto-generate meta descriptions

by default. Yoast SEO or similar plugins can manage these, but the setting may not be configured for taxonomy

(tag) pages.

Recommended fix — step by step

1. Log in to WordPress admin → Plugins, confirm you have Yoast SEO or All in One SEO Pack active; if not,

install Yoast SEO.

2. In WordPress admin, go to SEO → Titles & Metas → Taxonomies (or Tax. Settings depending on plugin

version).

3. Find the 'Tags' section and enable 'Show metadescription in search results.'

4. Set a template like '%%title%% | Liberty Buds NYC Cannabis' or write a static description for high-traffic

tags.

5. For the 'cdc' tag specifically: navigate to Posts → Tags, click 'cdc', scroll to the Yoast/SEO plugin meta box,

and enter: 'CDC regulations and updates for NY cannabis dispensaries — Liberty Buds NYC.'

6. Click 'Update' and run a crawler audit 48 hours later to confirm the meta description appears.

21. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-oil/

Rule: tier2.meta.no-description

What it means (plain English)

This tag page has no meta description—the 155-character summary that appears below your page title in

Google search results. Without it, Google generates a random snippet from your page content, which often

looks unprofessional and doesn't tell customers what they'll find.

https://libertybudsnyc.com/tag/cdc/
https://libertybudsnyc.com/tag/cannabis-oil/


Why it matters for your business: Missing descriptions reduce click-through rates from search results;

customers see a vague or irrelevant excerpt instead of a clear reason to visit your cannabis-oil product

category.

Technical root cause: WordPress tag pages typically inherit no auto-generated description by default. If you're

using Yoast SEO or Rank Math, the description field for this tag was left blank during setup.

Recommended fix — step by step

1. Log into WordPress admin → Posts → Tags (or navigate to the Tags page)

2. Find and click 'cannabis-oil' tag to edit it

3. Scroll to the Yoast SEO or Rank Math box (if installed) or look for a 'Description' field

4. Write a 155-character description: e.g., 'Shop premium cannabis oils at Liberty Buds NYC. Full-spectrum,

distillate, and flavored options. Same-day delivery available.'

5. Verify character count is 120–160 characters (Yoast shows a green light when correct)

6. Click 'Update' or 'Save'

7. Repeat for any other product tag pages (/tag/edibles/, /tag/flower/, etc.)

22. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-delivery-roosevelt-island/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'cannabis-delivery-roosevelt-island' is missing a meta description — the 155-character

snippet that appears below your page title in Google search results. Without it, Google generates a random

excerpt from your page content, which often looks unprofessional and doesn't encourage clicks. This is a quick

fix in WordPress.

Why it matters for your business: Missing meta descriptions reduce click-through rate from search results;

potential customers see a choppy, auto-generated preview instead of a clear call-to-action about Roosevelt

Island delivery.

Technical root cause: WordPress tag pages rarely have meta descriptions set by default. You likely have an

SEO plugin (Yoast, Rank Math, All in One SEO) but haven't configured descriptions for tag archive pages.

Recommended fix — step by step

1. Log into WordPress admin → go to Posts → Tags → find 'cannabis-delivery-roosevelt-island'

2. If you use Yoast SEO: click Edit tag → scroll to 'Yoast SEO' panel → paste a description like 'Fast cannabis

delivery to Roosevelt Island, NY. Order premium flower, edibles & concentrates. Licensed dispensary.' (max

155 characters)

3. If you use Rank Math: click Edit tag → scroll to 'Rank Math' → paste the same description in the 'Description'

field

4. If you use All in One SEO: click Edit tag → scroll down → paste description in 'Meta Description'

5. If no SEO plugin: install Yoast SEO free version (Plugins → Add New → search 'Yoast SEO' → Install &

Activate), then follow step 2

6. Save the tag

https://libertybudsnyc.com/tag/cannabis-delivery-roosevelt-island/


7. Run a re-index: in your SEO plugin settings, trigger 'Reindex Site' or wait 48 hours for Google to refresh

23. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/nyc-cannabis-delivery/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'nyc-cannabis-delivery' doesn't have a meta description — the 160-character summary that

appears under your page title in Google search results. Without it, Google generates a random snippet from

your page content, which may not highlight what makes your dispensary special or trustworthy.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results

because potential customers see incomplete or irrelevant previews of your page, causing them to click

competitors instead.

Technical root cause: WordPress tag pages often don't auto-generate meta descriptions; they require manual

input or a plugin setting to populate the SEO field for archive pages.

Recommended fix — step by step

1. Log into WordPress admin → Posts → Tags, then click 'nyc-cannabis-delivery'

2. Scroll to the SEO plugin section (Yoast, RankMath, All in One SEO, or similar) on that tag edit page

3. Fill the 'Meta Description' field with: 'Premium cannabis delivery in NYC. Liberty Buds offers fast, discreet

delivery of flower, edibles, and concentrates. Licensed & compliant. Order today.'

4. Set that description to exactly 155–160 characters (use the character counter in your SEO plugin)

5. Click Publish/Update

6. Repeat this for any other cannabis-related tag pages (check Settings → Reading → Posts per page to see if

tag archives are indexed)

24. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-gifts/

Rule: tier2.meta.no-description

What it means (plain English)

This tag page (for 'cannabis-gifts') doesn't have a meta description — the 50–160 character summary that

appears below your page title in Google search results. Without it, Google generates a random snippet from

your page content, which often looks unprofessional and doesn't encourage clicks.

Why it matters for your business: Missing meta descriptions on category and tag pages reduce click-through

rates from search results, directly lowering foot traffic to your site and losing potential customers to

competitors who have optimized their listings.

https://libertybudsnyc.com/tag/nyc-cannabis-delivery/
https://libertybudsnyc.com/tag/cannabis-gifts/


Technical root cause: WordPress doesn't auto-generate meta descriptions for tag archive pages. Either a SEO

plugin isn't activated, or it's not configured to create descriptions for tag pages.

Recommended fix — step by step

1. Install Yoast SEO (free) if not already active: Plugins → Add New → search 'Yoast SEO' → Install and

Activate.

2. Go to tag page in WordPress admin: Posts → Tags → hover over 'cannabis-gifts' → click 'Edit'.

3. Scroll down to the Yoast SEO meta box and add a meta description (50–160 characters) like: 'Shop unique

cannabis gift sets and accessories at Liberty Buds NYC. Same-day delivery available.'

4. Click Save.

5. Repeat for all other high-traffic tag pages (check Google Search Console → Pages → filter by tag URLs to

find which drive the most impressions).

6. Optional: In Yoast settings (Yoast SEO → Titles & Metas → Tag Archives), enable 'Show date in snippet

preview' and set a default template to auto-populate tags you forget.

25. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/self-care/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'self-care' doesn't have a meta description — that's the 2–3 sentence summary that appears

under your page title in Google search results. Without it, Google generates one automatically (often poorly),

which means potential customers see a less compelling preview and may skip your site.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

directly lowering foot traffic to your dispensary's product discovery pages.

Technical root cause: WordPress tag pages often lack manually-written meta descriptions because they're not

assigned per-tag by default; the tag archive template uses a generic or empty description field.

Recommended fix — step by step

1. Log into WordPress admin → Posts → Tags.

2. Find the 'self-care' tag and click Edit.

3. In the tag edit panel, scroll to find the 'Description' or meta description field (often provided by SEO plugins

like Yoast SEO or Rank Math).

4. Write a 155–160 character description, e.g.: 'Explore self-care cannabis products at Liberty Buds NYC.

Relaxation, wellness, and recovery items for mindful consumption.'

5. Save/Publish the tag.

6. If no description field exists, install Yoast SEO Free (Plugins → Add New → search 'Yoast' → Install &

Activate), then repeat steps 1–5; Yoast adds a dedicated meta description box to every tag edit screen.

26. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

https://libertybudsnyc.com/tag/self-care/


Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-sleep-aid/

Rule: tier2.meta.no-description

What it means (plain English)

This page is missing a meta description — the short text (usually 150–160 characters) that appears below your

page title in Google search results. Without it, Google will auto-generate a snippet from your page content,

which may be incomplete or unfocused. For a tag page like 'cannabis-sleep-aid,' a custom description helps

searchers understand what products or posts they'll find.

Why it matters for your business: Fewer clicks from search results because your listing looks less relevant or

compelling compared to competitors who have written descriptions; this directly reduces organic traffic to

product discovery pages.

Technical root cause: WordPress tag pages typically do not have a meta description field by default. The

theme or SEO plugin (if installed) needs to be configured to generate or allow custom descriptions for tag

archive pages.

Recommended fix — step by step

1. Install or activate Yoast SEO (if not already active): wp-admin → Plugins → search 'Yoast SEO' → activate.

2. Go to wp-admin → SEO → Search Appearance → Archives tab.

3. Find the 'Tags' row and toggle the 'Show tag archives in search results' switch ON.

4. In the same Tags row, click the pencil icon to edit the default meta description template.

5. Replace the template with a specific, benefit-focused description like: 'Discover cannabis products for sleep

and relaxation. Browse our curated selection of sleep aid strains and edibles at Liberty Buds NYC.'

6. Save changes.

7. Verify by visiting https://libertybudsnyc.com/tag/cannabis-sleep-aid/ and checking the page source (Ctrl+U,

search 'description') to confirm the meta tag appears.

27. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-for-sleep/

Rule: tier2.meta.no-description

What it means (plain English)

This tag page doesn't have a meta description — the 160-character summary that appears under your page title

in Google search results. Without it, Google generates random text from your page, which often looks broken or

irrelevant to searchers. This directly hurts click-through rates from search.

Why it matters for your business: Customers searching for 'cannabis for sleep' will see incomplete or

confusing preview text in Google results, causing them to skip your link and visit competitors instead.

Technical root cause: WordPress tag pages don't auto-generate meta descriptions by default. Either the SEO

plugin (Yoast, Rank Math, etc.) isn't configured to create them for taxonomy pages, or the setting is disabled.

Recommended fix — step by step

https://libertybudsnyc.com/tag/cannabis-sleep-aid/
https://libertybudsnyc.com/tag/cannabis-sleep-aid/
https://libertybudsnyc.com/tag/cannabis-for-sleep/


1. Log into WordPress Admin → Plugins. Verify you have an active SEO plugin (Yoast SEO, Rank Math, or All in

One SEO).

2. If using Yoast SEO: go to SEO → Titles & Metas → Archives → find 'Tags' and enable 'Meta description' with

a template like '%%title%% | Liberty Buds NYC'.

3. If using Rank Math: Settings → Titles & Meta → Tag, toggle 'Show Meta Description' on and set a template.

4. If using All in One SEO: go to All in One SEO → Titles & Meta → Archives → Tag and enable meta description

with a custom template.

5. Manually edit this specific tag page: WordPress Admin → Posts → Tags → click 'cannabis-for-sleep' → scroll

to the SEO plugin meta box → fill in a description like 'Discover cannabis strains and products for better

sleep at Liberty Buds NYC. Expert recommendations & reviews.'

6. Republish the tag page.

7. Check 2-3 other tag pages to confirm the issue is widespread, then apply the template fix to all at once via

the plugin settings.

28. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cbd-for-sleep/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'cbd-for-sleep' doesn't have a meta description — the 155-character summary that appears

under your page title in Google search results. Without it, Google generates a random snippet from your page

content, which often looks unprofessional and doesn't encourage clicks.

Why it matters for your business: Customers searching for CBD sleep products are less likely to click your link

in search results because they don't see a compelling description of what's on the page, directly reducing

organic traffic to product pages.

Technical root cause: WordPress tag pages typically don't auto-generate meta descriptions unless explicitly

configured via an SEO plugin or custom code. The Yoast SEO or Rank Math plugin isn't filling this field, or tag

pages are excluded from meta description settings.

Recommended fix — step by step

1. Log into WordPress admin → install or activate Yoast SEO (if not already active)

2. Navigate to Posts → Tags, then click on 'cbd-for-sleep' to edit it

3. Scroll to the Yoast SEO section at the bottom and paste a description like: 'Shop our premium CBD products

for sleep. Find trusted, lab-tested options to help you rest better.'

4. Set the focus keyword to 'CBD for sleep' if not already set

5. Click Save

6. Repeat for all other product tag pages (search your dashboard for other /tag/ pages)

7. Allow 1-2 weeks for Google to re-index and refresh search results

29. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

https://libertybudsnyc.com/tag/cbd-for-sleep/


Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/thc-recovery/

Rule: tier2.meta.no-description

What it means (plain English)

This tag archive page (for 'thc-recovery') doesn't have a meta description — the short text snippet that appears

below your site name in Google search results. Without it, Google may auto-generate a snippet from the page

content, which is often choppy or irrelevant. For a cannabis retailer, this means potential customers see a poor

preview and may skip your listing.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

directly hurting foot traffic to your dispensary and online sales.

Technical root cause: WordPress tag archive pages typically inherit a default template that doesn't

automatically generate or display meta descriptions. Tag pages are often overlooked because they're auto-

generated by the platform.

Recommended fix — step by step

1. Install the free Yoast SEO plugin if not already active: Dashboard → Plugins → Add New → search 'Yoast

SEO' → Install & Activate.

2. Go to Dashboard → SEO → Search Appearance → Archives tab.

3. Find 'Tags' in the list and toggle on 'Show' and 'Meta description'.

4. In the Meta description template field, enter: '%%title%% | Liberty Buds NYC' or similar (max 160

characters).

5. Save changes.

6. Visit https://libertybudsnyc.com/tag/thc-recovery/ and confirm the meta description now appears in the page

source (Ctrl+U, search 'og:description' or 'description').

7. Optional: Manually edit individual high-traffic tag pages in Yoast for more specificity (e.g., 'THC Recovery

Products at Liberty Buds NYC | Premium Cannabis').

30. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/category/events/

Rule: tier2.meta.no-description

What it means (plain English)

Your Events category page is missing a meta description — the 155-character text snippet that appears below

your page title in Google search results. Without it, Google generates a random excerpt from your page content,

which may not highlight your most important information or entice clicks.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers may skip your Events page for competitors with clearer, more compelling summaries.

Technical root cause: The WordPress category template for /category/events/ has no meta description tag in

the page head. By default, WordPress does not auto-generate descriptions for category archives unless a

plugin or custom code is configured to do so.

https://libertybudsnyc.com/tag/thc-recovery/
https://libertybudsnyc.com/tag/thc-recovery/
https://libertybudsnyc.com/category/events/


Recommended fix — step by step

1. Install the free Yoast SEO plugin (Plugins → Add New → search 'Yoast SEO' → Install and Activate).

2. Navigate to Posts → Categories in the WordPress admin.

3. Click the Events category to edit it.

4. Scroll to the Yoast SEO panel at the bottom and enter a description in the 'Snippet editor' field (aim for 150–

160 characters; Yoast will show you a live preview).

5. Example: 'Liberty Buds NYC Events — discover product launches, educational workshops, and community

gatherings. Check dates & register.'

6. Click Update to save.

7. Repeat this process for any other category pages (Products, Blog, etc.) that lack descriptions.

31. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/category/lifestyle-culture/

Rule: tier2.meta.no-description

What it means (plain English)

This archive page (a collection of blog posts about lifestyle and culture) has no meta description — the 155-

character summary that appears below your page title in Google search results. Without it, Google generates a

random snippet from your page content, which often looks unprofessional and doesn't tell customers what to

expect.

Why it matters for your business: Missing descriptions on category pages reduce click-through rates from

search results, costing you organic traffic and potential customers who might otherwise visit your blog and stay

engaged with your brand.

Technical root cause: The WordPress category page template likely has no custom meta description field

populated, and no SEO plugin default is filling it in automatically.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: go to Plugins → Add New → search 'Yoast SEO' →

Install and Activate

2. Navigate to Posts → Categories in the WordPress admin sidebar

3. Click 'Lifestyle & Culture' to edit that category

4. Scroll to the Yoast SEO box at the bottom of the page (or in the right sidebar)

5. In the 'SEO title' and 'Meta description' fields, write a 155-character description like: 'Explore cannabis

lifestyle tips, culture, and community stories at Liberty Buds NYC. Stay informed on trends and cannabis

wellness.'

6. Click 'Update' to save

7. Repeat this process for all other category pages on your site

32. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

https://libertybudsnyc.com/category/lifestyle-culture/


Business category: seo

Page URL: https://libertybudsnyc.com/category/uncategorized/

Rule: tier2.meta.no-description

What it means (plain English)

Your category archive page (Uncategorized) doesn't have a meta description — the 160-character summary

that appears below your page title in Google search results. Without it, Google generates a generic snippet that

may not entice clicks or clearly explain what visitors will find.

Why it matters for your business: Lower click-through rates from search results, especially for users browsing

cannabis product categories; missing opportunity to communicate trust, licensing, or product range in the

search preview.

Technical root cause: WordPress category pages default to no meta description unless explicitly set via SEO

plugin or custom code. The Uncategorized category likely has no description field populated in the WordPress

admin.

Recommended fix — step by step

1. Install or activate Yoast SEO (if not already active): Dashboard → Plugins → search 'Yoast SEO' → Install &

Activate.

2. Navigate to Posts → Categories, click 'Uncategorized', scroll to the Yoast SEO section at bottom.

3. Fill the 'Meta description' field with a concise 150–160 character description, e.g., 'Browse our full selection

of cannabis products — flower, edibles, concentrates, and accessories at Liberty Buds NYC.'

4. Ensure the description fits the preview bar (Yoast will show green when optimal length is met).

5. Click 'Update' to save.

6. Repeat for any other category archives (Products, Specials, etc.) that lack descriptions.

33. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/nyc-subway/

Rule: tier2.meta.no-description

What it means (plain English)

This tag page (one that groups content about 'NYC subway') has no meta description — the 2–3 sentence

summary that appears under your page title in Google search results. Without it, Google generates a random

snippet from your page content, which often looks awkward and doesn't sell your business.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see incomplete or irrelevant text and choose competitors instead.

Technical root cause: Tag archive pages in WordPress often inherit a default template that omits meta

description tags. The theme or SEO plugin hasn't configured dynamic descriptions for taxonomy pages.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: WordPress Admin → Plugins → Add New → search

'Yoast SEO' → Install and Activate

2. Go to WordPress Admin → Yoast SEO → Titles & Metas → Taxonomies → select 'Tags'

https://libertybudsnyc.com/category/uncategorized/
https://libertybudsnyc.com/tag/nyc-subway/


3. Enable the toggle for 'Show' tags in search results, then set a description template like: '%%term_title%%

cannabis products in %%sitename%%. Browse curated selections and availability.'

4. Go to Posts → Tags → click 'NYC Subway' tag → scroll to Yoast SEO box → write a custom 150–160

character description: 'NYC subway-accessible cannabis products at Liberty Buds. Fast delivery & curated

selection.'

5. Click 'Update' to save

6. Verify in Google Search Console (Admin → Reporting → Coverage) that the page is indexed; wait 2–3 weeks

for snippet to refresh in live search results

34. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-commuting/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag archive page for 'cannabis-commuting' doesn't have a meta description — the 50–160 character

summary that appears below your page title in Google search results. Without it, Google generates a random

snippet from your page content, which often looks unprofessional and fails to tell searchers why they should

click.

Why it matters for your business: This tag page likely receives organic search traffic; a missing description

reduces click-through rate from search results, costing you foot traffic and online orders.

Technical root cause: WordPress tag archive pages typically inherit the site's default meta description (or none

at all) unless you explicitly set a custom description per tag using an SEO plugin like Yoast SEO or Rank Math.

Recommended fix — step by step

1. Install Yoast SEO plugin (if not already active): WordPress Admin → Plugins → Add New → search 'Yoast

SEO' → Install & Activate.

2. Go to WordPress Admin → Tags → hover over 'cannabis-commuting' → click Edit.

3. Scroll down to the Yoast SEO box → in the 'Keyphrase' field, enter a target keyword (e.g., 'cannabis

commuting in NYC').

4. In the 'Meta description' field, write a unique 50–160 character description (e.g., 'Explore commuting-

friendly cannabis products at Liberty Buds NYC. Fast checkout, delivery & in-store options.').

5. Click 'Update' to save.

6. Repeat for any other high-traffic tag pages (use Google Search Console → Performance → filter by 'tag/' to

see which get the most impressions).

35. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/edibles-nyc/

Rule: tier2.meta.no-description

https://libertybudsnyc.com/tag/cannabis-commuting/
https://libertybudsnyc.com/tag/edibles-nyc/


What it means (plain English)

Your tag page for 'edibles-nyc' is missing a meta description — the 155-character summary that appears below

your page title in Google search results. Without it, Google generates its own snippet from your page content,

which is often fragmented and less compelling. This reduces click-through rates from search.

Why it matters for your business: Customers searching for 'edibles in NYC' won't see a persuasive

description of your products or offers, leading to lower search traffic and lost sales to competitors with

optimized listings.

Technical root cause: WordPress tag pages do not auto-generate meta descriptions by default. Most SEO

plugins (Yoast, Rank Math, All in One SEO) require you to manually write or enable auto-generation for

taxonomy archive pages.

Recommended fix — step by step

1. Log into WordPress admin → go to Posts → Tags and click the 'edibles-nyc' tag to edit it

2. If using Yoast SEO: scroll to the Yoast SEO metabox → click 'Edit snippet' → write a description like 'Shop

premium edibles at Liberty Buds NYC. Legal, lab-tested products delivered. Browse our collection of

gummies, chocolates & more.'

3. If using Rank Math: scroll to Rank Math section → paste the same description into the 'Meta Description'

field

4. Ensure description is 150–160 characters (Yoast shows a green light when optimal)

5. Click Update and verify the description appears in a Google search result preview within 48 hours using

Google Search Console

36. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/best-albums-for-smoking-weed/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'best-albums-for-smoking-weed' has no meta description — that's the 155-character

summary that appears below your link in Google search results. Without it, Google auto-generates a snippet

from your page content, which often looks choppy and doesn't convince people to click.

Why it matters for your business: Lower click-through rates from search results mean fewer visitors

discovering your community content, reducing engagement and time on site.

Technical root cause: WordPress tag pages typically inherit a default (blank) meta description from your theme

or SEO plugin settings. The tag archive template is not overriding this with custom text.

Recommended fix — step by step

1. Install or open Yoast SEO (if not already active): Plugins → Installed Plugins, or Plugins → Add New → search

'Yoast SEO'

2. Go to SEO → Search Appearance → Archives

3. Find 'Tag Archives' section and enable the toggle for 'Show date in snippets' and 'Meta description'

4. In the 'Meta description template' field for tag archives, enter a dynamic template like: %%title%% —

explore community perspectives on cannabis culture at Liberty Buds NYC

https://libertybudsnyc.com/tag/best-albums-for-smoking-weed/


5. Click 'Save Changes'

6. Navigate to the affected tag page in WordPress: Posts → Tags, click the tag 'best-albums-for-smoking-

weed', and manually enter a custom description (e.g., 'Best albums to enjoy while smoking weed. Join the

Liberty Buds NYC community to discover recommendations and reviews.') in the Yoast SEO meta description

box if available

7. Regenerate the page in your browser (Ctrl+Shift+R) and check the page source to confirm the meta

description tag now appears in <head>

37. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/weed-friendly-music/

Rule: tier2.meta.no-description

What it means (plain English)

This tag page has no meta description — the 155-character summary that appears below your URL in Google

search results. Without it, Google shows a random snippet from the page, which often looks broken or irrelevant

to customers searching for cannabis products or strains.

Why it matters for your business: Poorly formatted search results reduce click-through rates from Google;

potential customers skip your listing in favor of competitors with clear, compelling descriptions.

Technical root cause: WordPress tag pages typically inherit the site's default meta description (if set globally),

but this one has none configured. Tag-specific descriptions are often overlooked during SEO setup.

Recommended fix — step by step

1. Log in to WordPress admin → Settings → Reading → verify 'Tagline' is set (this serves as fallback for tag

pages); if blank, enter a 155-character description like 'Explore cannabis strains, edibles, and products at

Liberty Buds NYC — your trusted dispensary.'

2. Install the free Yoast SEO plugin (Plugins → Add New → search 'Yoast SEO' → Install & Activate) if not

already active.

3. Navigate to the tag page (Yoast will add an editor) or go to Posts → Tags in WordPress admin.

4. Click the 'weed-friendly-music' tag to edit it.

5. Scroll to the Yoast SEO meta box at the bottom → 'Meta description' field → write a 155-character

description specific to that tag (e.g., 'Cannabis picks for your playlist — the best weed strains and products

to enhance music enjoyment.')

6. Click 'Update' and verify the change appears in a Google search preview (refresh Google's cache in 1–2

weeks).

38. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/sesh-playlist/

Rule: tier2.meta.no-description

https://libertybudsnyc.com/tag/weed-friendly-music/
https://libertybudsnyc.com/tag/sesh-playlist/


What it means (plain English)

Your tag page for 'sesh-playlist' is missing a meta description — the 2–3 sentence summary that appears below

your page title in Google search results. Without it, Google generates a random excerpt from your page, which

often looks unprofessional and doesn't tell customers what they'll find.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

meaning fewer visitors discover your content and promotions even if your pages rank.

Technical root cause: WordPress tag pages typically auto-generate without custom meta descriptions. The tag

template hasn't been configured to output a description, and no SEO plugin default has been set for this archive

type.

Recommended fix — step by step

1. Install or activate Yoast SEO (free version) if not already active: WordPress Admin → Plugins → search 'Yoast

SEO' → Activate.

2. In WordPress Admin, go to Posts → Tags and click 'sesh-playlist'.

3. Scroll down to the Yoast SEO box and fill in the Meta description field with: 'Curated cannabis-friendly

playlists and music recommendations for Liberty Buds NYC customers.' (under 160 characters).

4. Click 'Update' to save.

5. In Yoast SEO settings (Admin → SEO → Search Appearance → Taxonomies), verify that 'Show tag in search

results' is enabled and check the default snippet template for tags includes %%tag_description%%.

6. Use Google Search Console (Admin → Yoast SEO → Integrations → Google Search Console) to request re-

indexing of this URL after saving.

39. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/celebrity-cannabis-style/

Rule: tier2.meta.no-description

What it means (plain English)

This page has no meta description — the 155-character snippet that appears below your page title in Google

search results. Without it, Google generates a random excerpt from your page content, which often looks

unprofessional and doesn't tell customers what they'll find. For tag pages especially, a clear description helps

searchers decide whether to click.

Why it matters for your business: Tag pages without descriptions get lower click-through rates from search

results, losing potential customers who might otherwise visit your site to browse cannabis products or learn

about your brand.

Technical root cause: WordPress tag pages typically inherit no meta description by default. The tag template

isn't configured to auto-generate or pull descriptions from tag content, so search engines see a blank field.

Recommended fix — step by step

1. Log in to WordPress admin → Tags → find 'celebrity-cannabis-style' tag → click Edit.

2. Install the free Yoast SEO plugin (if not already installed): Plugins → Add New → search 'Yoast SEO' → Install

& Activate.

3. Return to Tags and open 'celebrity-cannabis-style' again; scroll to the Yoast SEO metabox below the editor.

https://libertybudsnyc.com/tag/celebrity-cannabis-style/


4. In the 'SEO title' and 'Meta description' fields, write a 150–160 character description: e.g., 'Explore celebrity

cannabis style tips & product picks at Liberty Buds NYC. Curated recommendations for discerning

customers.'

5. Click 'Update' to save.

6. Repeat for other tag pages (check Search Console → Pages → filter by /tag/ to find all affected tags).

40. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/weed-culture-and-fashion/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'weed-culture-and-fashion' is missing a meta description — the 150-160 character summary

that appears under your page title in Google search results. Without it, Google generates a random snippet from

your page content, which often looks incomplete or unprofessional and may not encourage clicks.

Why it matters for your business: Missing meta descriptions reduce click-through rate from search results,

meaning fewer visitors discover your community content and fewer opportunities to build brand loyalty or drive

foot traffic to your dispensary.

Technical root cause: WordPress tag pages typically inherit a generic or empty description from theme

defaults. The tag template likely has no custom description field filled in, and your SEO plugin (if present) isn't

auto-generating one.

Recommended fix — step by step

1. Log into WordPress admin → Posts → Tags, find 'weed-culture-and-fashion' and edit it.

2. If you use Yoast SEO or Rank Math, scroll to the SEO section and write a unique meta description (150–160

characters) — e.g., 'Explore the intersection of cannabis and fashion. Discover trends, style tips, and cultural

conversations at Liberty Buds NYC.'

3. If no SEO plugin is active, install and activate Yoast SEO (free version) from WordPress plugins.

4. Repeat this for all other tag pages you want to rank (check Search Console → Pages to see which tags get

impressions).

5. After saving, wait 1–2 weeks for Google to re-crawl and update the search snippet.

41. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/memorial-day/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'memorial-day' is missing a meta description — a 155–160 character snippet that appears

below your page title in Google search results. Without it, Google will auto-generate text from your page, which

is often choppy and doesn't encourage clicks. This tag page currently shows no summary to searchers.

https://libertybudsnyc.com/tag/weed-culture-and-fashion/
https://libertybudsnyc.com/tag/memorial-day/


Why it matters for your business: Lower click-through rate from search results because potential customers

see incomplete or irrelevant preview text instead of a compelling description of what's on that page.

Technical root cause: WordPress does not automatically generate meta descriptions for tag archive pages.

Your theme or SEO plugin (if installed) is not filling this field, so the tag page is published without one.

Recommended fix — step by step

1. Install or verify Yoast SEO (free version) is active: WordPress Admin → Plugins → search 'Yoast SEO' →

activate if not already active.

2. Go to WordPress Admin → Posts → Tags, find 'memorial-day', and click Edit.

3. In the Yoast SEO meta box (below the tag description), paste a description like: 'Memorial Day cannabis

deals and specials at Liberty Buds NYC. Shop premium flower, edibles, and concentrates with holiday

discounts.'

4. Click Update Tag.

5. Repeat for any other tag archive pages that rank in search (use Google Search Console to identify high-

traffic tags).

6. In Yoast SEO settings (WordPress Admin → Yoast SEO → Search Appearance → Taxonomies), ensure 'Tag

archives' are set to 'Show in search results' and enable the meta description template if available.

42. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/legal-cannabis-nyc/

Rule: tier2.meta.no-description

What it means (plain English)

This tag archive page (/tag/legal-cannabis-nyc/) is missing a meta description — the 150–160 character

summary that appears below your page title in Google search results. Without it, Google generates its own

excerpt, which often looks unprofessional and may not highlight your key message about legal cannabis in NYC.

Why it matters for your business: Missing meta descriptions reduce click-through rate from search results;

potential customers see a generic snippet instead of a compelling reason to visit your site, directly impacting

foot traffic and online orders.

Technical root cause: WordPress tag archive pages often lack auto-generated meta descriptions because the

tag template does not have a description field or SEO plugin configuration to populate it. This is especially true

if a recent WordPress or theme update reset default behavior.

Recommended fix — step by step

1. Log in to WordPress admin dashboard and install/activate Yoast SEO (if not already active).

2. Navigate to SEO → Titles & Metas in the left sidebar.

3. Find the 'Taxonomies' section and click 'Tags'.

4. In the 'Meta description template' field, enter: '%%term_title%% | Premium Cannabis Products | Liberty

Buds NYC – Licensed & Legal'.

5. Click 'Save Changes'.

6. Go to Posts → Tags, find 'legal-cannabis-nyc', click to edit it, and manually add a description in the SEO

plugin's meta description box (e.g., 'Explore our premium legal cannabis selection in NYC. Licensed

products, lab-tested, and compliant with NY regulations.').

https://libertybudsnyc.com/tag/legal-cannabis-nyc/


7. Publish/update the tag and wait 1–2 hours for Google to re-crawl.

43. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-and-art/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'cannabis-and-art' doesn't have a meta description — the 50-160 character summary that

appears under your page title in Google search results. Without it, Google generates a random snippet from

your page content, which often looks unprofessional and doesn't encourage clicks.

Why it matters for your business: Visitors searching for cannabis-related content miss a compelling reason to

click your link; lower click-through rate from search results means less traffic and fewer potential customers.

Technical root cause: WordPress tag pages typically don't auto-generate meta descriptions unless explicitly

set per-tag or configured via an SEO plugin like Yoast or Rank Math.

Recommended fix — step by step

1. Install Yoast SEO (free version) via WordPress Admin → Plugins → Add New, search 'Yoast', click Install and

Activate.

2. Go to WordPress Admin → Posts → Tags, click the 'cannabis-and-art' tag to edit it.

3. Scroll to the Yoast SEO box at the bottom; paste a description like 'Explore cannabis art, events, and cultural

moments at Liberty Buds NYC.' (55–160 characters).

4. Repeat for other high-traffic tag pages (e.g., 'cannabis-strains', 'wellness').

5. Enable Yoast's 'Auto-generate meta descriptions' for new tags: Admin → Yoast SEO → Tools →

import/export, or check Yoast → Integration to auto-generate if none exists.

44. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-and-food/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'cannabis-and-food' doesn't have a meta description — the 50-160 character summary that

appears under your site link in Google search results. Without it, Google generates a random snippet from your

page content, which often looks unprofessional and misses your key selling points.

Why it matters for your business: Dispensaries rely on search traffic for foot traffic and online orders; a

missing description reduces click-through rate from search results and makes your listing appear incomplete

compared to competitors.

Technical root cause: WordPress tag pages typically auto-generate without meta descriptions unless you

explicitly add them via an SEO plugin (like Yoast SEO or Rank Math) or manual code. Tag archive pages are

https://libertybudsnyc.com/tag/cannabis-and-art/
https://libertybudsnyc.com/tag/cannabis-and-food/


often overlooked in SEO setup.

Recommended fix — step by step

1. Install Yoast SEO (free tier) if not already active: WordPress admin → Plugins → Add New → search 'Yoast

SEO' → Install Now → Activate.

2. Go to WordPress admin → Posts → Tags, click 'Edit' on the 'cannabis-and-food' tag.

3. Scroll to the Yoast SEO box at the bottom; in the 'Snippet preview' section, click 'Edit snippet' and enter a

description: e.g., 'Explore cannabis food pairings and edibles at Liberty Buds NYC. Shop gummies, infused

treats, and expert pairing guides.'

4. Ensure description is 50-160 characters and includes 'Liberty Buds NYC' and a benefit (pairings, edibles,

expert advice).

5. Click 'Update' on the tag page.

6. Repeat for other high-traffic tag pages (at minimum: 'cannabis-products', 'dispensary', brand names you

carry).

45. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-drinks/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'cannabis-drinks' doesn't have a meta description — the 50–160 character summary that

appears below your page title in Google search results. Search engines generate a default snippet instead,

which is often choppy or unhelpful. This reduces click-through rate from search results because potential

customers can't quickly understand what's on the page.

Why it matters for your business: Missing meta descriptions on category and tag pages lower click-through

rates from Google, directly reducing traffic and sales for high-intent product searches.

Technical root cause: WordPress tag pages typically don't auto-generate meta descriptions by default unless

an SEO plugin (like Yoast, Rank Math, or All in One SEO) is configured to create them. The tag archive page is

likely not covered by a blanket template rule.

Recommended fix — step by step

1. Log in to WordPress admin → Plugins → check if Yoast SEO, Rank Math, or All in One SEO is installed; if not,

install one (Yoast is most common for cannabis retail).

2. If using Yoast: go to WordPress admin → Yoast SEO → Title & Meta → Titles & Metas → find the 'Tag' section

and enable 'Show in search results'.

3. In that same section, set a meta description template for tags using variables like '%%title%% |

%%sitename%%' or 'Browse our %%title%% products at Liberty Buds NYC.'

4. Navigate to Posts → Tags → click 'cannabis-drinks' → scroll to the SEO section → manually enter a 160-

character description: e.g., 'Shop premium cannabis-infused drinks at Liberty Buds NYC. Wide selection of

beverages. Browse today.'

5. If using Rank Math: go to WordPress admin → Rank Math → Titles & Meta → Tags section → enable

descriptions and set template.

https://libertybudsnyc.com/tag/cannabis-drinks/


6. Save and verify the meta description appears in Google's mobile preview tool (search.google.com → URL

Inspection).

7. Repeat for all other tag pages (tag/cannabis-edibles/, tag/cannabis-flower/, etc.).

46. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-beverages/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'cannabis-beverages' is missing a meta description — the 50–160 character summary that

appears under your site name in Google search results. Without it, Google generates a random snippet from

your page, which often looks unprofessional and reduces click-through rates. This is a quick fix in WordPress.

Why it matters for your business: Missing meta descriptions on tag pages reduce the likelihood that people

searching for cannabis beverages will click through to your site, even if you rank well — you lose potential foot

traffic and online orders.

Technical root cause: WordPress tag archives do not auto-generate meta descriptions by default. Most SEO

plugins (Yoast, Rank Math, All in One SEO) can populate these automatically or let you set them per tag, but the

setting may not be enabled or configured for tag pages.

Recommended fix — step by step

1. Log into WordPress admin → go to Posts → Tags

2. Click on the 'cannabis-beverages' tag to edit it

3. If you use Yoast SEO: scroll to the Yoast SEO box → click 'Edit snippet' → paste a description like 'Shop

premium cannabis beverages at Liberty Buds NYC. Wide selection of edibles, drinks & infusions delivered

fast.'

4. If you use Rank Math: scroll to the Rank Math box → enter the description in the 'Meta Description' field (aim

for 50–160 characters)

5. If you see no SEO fields: install either Yoast SEO or Rank Math from Plugins → Add New, activate it, then

return to Tags and repeat steps 2–4

6. Click Update, then test by searching 'cannabis beverages NYC' on Google and refresh the cache (Google

Search Console → URL Inspection → Request Indexing)

47. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/thc-label/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'thc-label' doesn't have a meta description — the 50–160 character summary that appears

below your page title in Google search results. Without it, Google generates a random snippet from your page,

https://libertybudsnyc.com/tag/cannabis-beverages/
https://libertybudsnyc.com/tag/thc-label/


which often looks unprofessional and may hurt click-through rates.

Why it matters for your business: Low click-through rate from search results means fewer potential customers

visiting your site; tag pages are often indexed and ranked, so this affects organic traffic and brand perception.

Technical root cause: WordPress tag archives don't automatically inherit meta descriptions from the site-wide

SEO settings. The tag page was created without manually adding a description via an SEO plugin or theme

setting.

Recommended fix — step by step

1. Install or confirm you have Yoast SEO or RankMath active (Settings → Plugins → search 'Yoast' or

'RankMath')

2. Go to Posts → Tags and click 'thc-label'

3. Scroll to the Yoast/RankMath meta box at the bottom of the edit screen

4. In the 'Meta description' field, write 150–160 characters describing posts tagged with 'thc-label' (e.g.,

'Explore THC labeling requirements, potency guides, and compliance tips for NY cannabis retailers')

5. Click 'Update' to save

6. Repeat for any other tag pages you want to rank (check Google Search Console → Performance → Queries

for tags with high impressions but low CTR)

48. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-label/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'cannabis-label' doesn't have a meta description — that's the 50-160 character summary that

appears below your page title in Google search results. Without it, Google may auto-generate one from your

page text, which often looks unprofessional or doesn't match what you want customers to see.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results

because potential customers see a generic snippet instead of a compelling reason to visit your site.

Technical root cause: WordPress tag pages don't auto-generate meta descriptions by default unless your SEO

plugin is configured to do so, or unless you manually add them.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: go to Plugins → Add New, search 'Yoast SEO', click

Install Now and Activate.

2. Navigate to Posts → Tags, find 'cannabis-label', and click Edit.

3. Scroll to the Yoast SEO meta box below the editor and write a unique description like: 'Shop cannabis

products with detailed labeling info at Liberty Buds NYC. View strain details, THC/CBD content, and

compliance info.'

4. Ensure the description is 50-160 characters and includes your location + key benefit.

5. Click Update to save.

6. Repeat this process for any other tag pages you want to rank (or use Yoast's bulk edit feature to set a

template for all tags).

https://libertybudsnyc.com/tag/cannabis-label/


49. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cbg/

Rule: tier2.meta.no-description

What it means (plain English)

Meta descriptions are the short text snippets that appear below your page title in Google search results.

Without one, Google will auto-generate something from your page content, which is often awkward or

incomplete. For tag pages like '/tag/cbg/', a missing description means potential customers see a poor preview

when they search for CBG products.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results

because customers see generic or irrelevant text instead of a compelling reason to visit your CBG product tag

page.

Technical root cause: WordPress tag pages typically inherit default meta description behavior; either the SEO

plugin (Yoast, Rank Math, etc.) is not configured to auto-generate descriptions for taxonomy pages, or no

custom description was manually set.

Recommended fix — step by step

1. Log in to WordPress admin and install or activate Yoast SEO (if not already active) via Plugins → Add New →

search 'Yoast SEO' → Install → Activate

2. Navigate to Yoast SEO → Settings → Titles & Metas → Taxonomies tab

3. Find the Tags row and set 'Display metadescription snippet' to ON

4. Set the default template to something like '%%title%% | Premium Cannabis Products at Liberty Buds NYC'

(%%title%% auto-fills with the tag name)

5. Go to Posts → Tags, click the CBG tag, scroll to the Yoast SEO box at the bottom, and manually enter a

description like 'Explore our selection of high-quality CBG products in NYC. Lab-tested, compliant, and

delivered fast.' (aim for 155–160 characters)

6. Repeat step 5 for other high-traffic tag pages (Delta-8, THC, etc.)

7. Save changes and submit the /tag/cbg/ URL to Google Search Console → URL Inspection → Request

Indexing to refresh the search result snippet

50. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cbn/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for "cbn" doesn't have a meta description — the 160-character summary that appears below your

page title in Google search results. Without it, Google will auto-generate one from your page content, which

often looks choppy and doesn't encourage clicks.

https://libertybudsnyc.com/tag/cbg/
https://libertybudsnyc.com/tag/cbn/


Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

meaning fewer visitors find your product pages even if you rank well for cannabinoid-related searches.

Technical root cause: WordPress tag archives don't auto-generate meta descriptions by default. The SEO

plugin (if installed) either isn't configured to create them for tag pages, or the setting is disabled.

Recommended fix — step by step

1. Install Yoast SEO if not already active: WordPress dashboard → Plugins → Add New → search 'Yoast SEO' →

Install and Activate

2. Go to WordPress dashboard → Yoast SEO → Settings → Titles & Metas

3. Find the 'Archives' tab and locate the 'Tags' row

4. Enable the meta description template and set it to something like: '%%title%% | Liberty Buds NYC —

Premium Cannabis Products' (Yoast will auto-fill %%title%% with the tag name)

5. Save settings; Yoast will regenerate meta descriptions for all existing tag pages

6. Alternatively, if using a lighter plugin: install 'All in One SEO' → go to All in One SEO → Titles & Metas →

Archives tab → set tag template and save

51. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/live-resin/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'live-resin' doesn't have a meta description — that's the 2-3 sentence summary Google shows

under your page title in search results. Without it, Google auto-generates a snippet that may not highlight your

best content, and searchers have less reason to click your link.

Why it matters for your business: Low click-through rate from organic search for cannabis product tags

means fewer potential customers discover your live resin inventory.

Technical root cause: WordPress tag archives often inherit default settings or no description field is filled in.

The tag page template either lacks a dedicated meta description field or the field was left blank.

Recommended fix — step by step

1. Log into WordPress admin → Posts → Tags → click 'live-resin'

2. Scroll to 'SEO' section (if using Yoast SEO) or look for 'Meta Description' field in your theme/plugin settings

3. Write a unique 155–160 character description emphasizing live resin products available at Liberty Buds (e.g.,

'Shop premium live resin cannabis at Liberty Buds NYC. Fresh, potent concentrates in stock.')

4. Save changes and test by searching 'site:libertybudsnyc.com live resin' in Google after 48 hours to see the

updated snippet

52. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

https://libertybudsnyc.com/tag/live-resin/


Page URL: https://libertybudsnyc.com/tag/distillate/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag archive page for 'distillate' is missing a meta description—the 50–160 character summary that appears

under your site name in Google search results. Without one, Google will auto-generate a snippet, which is often

less compelling and may hurt click-through rates from search.

Why it matters for your business: Missing meta descriptions reduce organic click-through rate on tag pages,

shrinking free traffic and potential customer inquiries for product-related searches.

Technical root cause: WordPress tag archive pages do not auto-generate meta descriptions by default. Most

SEO plugins (Yoast, Rank Math, etc.) require manual input or a template rule to populate them.

Recommended fix — step by step

1. Log into WordPress admin → Plugins, search for 'Yoast SEO' or 'Rank Math' if not installed; install and

activate

2. Go to SEO plugin settings → Titles & Metas → click 'Taxonomies' or 'Tag Pages'

3. In the template field for tag pages, add a dynamic description template, e.g., '%%term_title%% cannabis

products | Liberty Buds NYC' (exact field name varies by plugin)

4. Alternatively, manually edit the tag: go to Posts → Tags → click 'distillate' → scroll to the SEO plugin box →

fill in the meta description field with 'High-quality distillate products. Browse our selection of cannabis

distillates at Liberty Buds NYC.'

5. Save and verify in Google Search Console that the description appears in a fresh search result (may take 1–2

weeks to index)

53. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/roosevelt-island-dispensary/

Rule: tier2.meta.no-description

What it means (plain English)

This tag archive page doesn't have a meta description — the 155-character summary that appears under your

page title in Google search results. Without it, Google generates a random snippet from your page, which often

looks unprofessional and may not mention your dispensary's key info.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see a generic or confusing preview instead of a compelling reason to visit your Roosevelt

Island dispensary listing.

Technical root cause: WordPress tag archive pages typically don't auto-generate meta descriptions by default.

The SEO plugin (if installed) may not be configured to create them, or the plugin is missing entirely.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: go to WordPress Admin → Plugins → Add New → search

'Yoast SEO' → Install & Activate

2. After activation, go to WordPress Admin → Yoast SEO → Settings → Taxonomies → toggle 'Show Tag in

search results' to ON

https://libertybudsnyc.com/tag/distillate/
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3. Navigate to Posts → Tags → click 'Roosevelt Island Dispensary' tag → scroll to Yoast SEO meta box at

bottom → fill in the 'Snippet Preview' description field with 60–155 characters (e.g., 'Find Roosevelt Island

cannabis dispensary | Liberty Buds NYC | Licensed & Safe')

4. Click Update/Save

5. Repeat for other tag archive pages with missing descriptions (check WordPress Admin → Posts → Tags for

any without Yoast descriptions)

54. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/mothers-day/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'mothers-day' is missing a meta description — the 50-160 character summary that appears

below your page title in Google search results. Without it, Google may auto-generate a snippet from your page

content, which is often less compelling and may not include your key message.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see a generic excerpt instead of your crafted message, losing traffic to competitors with

better search snippets.

Technical root cause: WordPress tag pages do not auto-generate meta descriptions by default, and no SEO

plugin (like Yoast or Rank Math) has been configured to create them, or the tag archive template lacks

description fields.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: go to Plugins → Add New, search 'Yoast SEO', click

Install & Activate.

2. Once activated, visit Posts → Tags in the WordPress admin and click the 'mothers-day' tag to edit it.

3. Scroll down to the Yoast SEO meta box and fill in the 'SEO title' and 'Meta description' fields with a custom

message (e.g., 'Shop Mother's Day Cannabis Gifts at Liberty Buds NYC – Premium Selection & Fast

Delivery').

4. Ensure the meta description is 50–160 characters and includes your location + key product/service.

5. Click Update and monitor Google Search Console (Search Results tab) within 2 weeks to confirm the new

snippet appears.

55. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cbd-for-anxiety/

Rule: tier2.meta.no-description

What it means (plain English)

https://libertybudsnyc.com/tag/mothers-day/
https://libertybudsnyc.com/tag/cbd-for-anxiety/


Your tag page for 'CBD for anxiety' has no meta description—the short text snippet that appears under your

page title in Google search results. Without it, Google generates a random excerpt from your page content,

which often looks unprofessional and may not convince people to click through from search.

Why it matters for your business: Missing meta descriptions reduce click-through rates from organic search;

customers searching for CBD anxiety relief may skip your result in favor of competitors who have clear, benefit-

focused descriptions.

Technical root cause: WordPress does not auto-generate meta descriptions for tag archive pages by default.

The Yoast SEO or Rank Math plugin can add them, but the description field was either never filled in or the

plugin is not active on this tag page.

Recommended fix — step by step

1. Install Yoast SEO plugin if not already active (Search → Plugins → Add New, search 'Yoast SEO', Install &

Activate).

2. Navigate to Posts → Tags in WordPress admin and click 'CBD for anxiety'.

3. Scroll to the Yoast SEO meta box and fill the 'Meta description' field with a benefit-focused 155–160

character phrase such as 'Discover CBD products for anxiety relief at Liberty Buds NYC. Lab-tested, fast

shipping, and expert guidance.'

4. Click 'Update' and verify the snippet preview in Yoast shows your description without being cut off.

5. Repeat this process for any other tag archive pages that serve as traffic drivers (e.g., 'CBD for pain', 'Delta-

8 products').

56. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/cannabis-for-stress-relief/

Rule: tier2.meta.no-description

What it means (plain English)

This archive page about 'cannabis for stress relief' has no meta description — the 50–160 character summary

that appears below your page title in Google search results. Without it, Google generates a random snippet from

your page content, which often looks unprofessional and doesn't encourage clicks.

Why it matters for your business: Customers searching for stress-relief cannabis products see a truncated or

irrelevant preview instead of a compelling reason to visit your site, reducing click-through rate from search and

losing foot traffic to competitors.

Technical root cause: WordPress tag archive pages rarely have meta descriptions auto-generated; they require

manual entry via an SEO plugin (Yoast, Rank Math, etc.) or direct theme customization.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: WordPress admin → Plugins → Add New → search

'Yoast SEO' → Install & Activate

2. Navigate to WordPress admin → Posts → Tags, then click the 'cannabis-for-stress-relief' tag to edit it

3. Scroll to the Yoast SEO meta box below the tag description field

4. In the 'Meta description' field, write: 'Explore premium cannabis products for stress relief at Liberty Buds

NYC. Trusted quality & expert guidance.' (60–75 chars)

5. Click 'Update' to save

https://libertybudsnyc.com/tag/cannabis-for-stress-relief/


57. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/post-work-relaxation/

Rule: tier2.meta.no-description

What it means (plain English)

Search results on Google show a brief text snippet under your page title — that's the meta description. This tag

page is missing that snippet, so Google will auto-generate one from your page text, which is often choppy or

irrelevant. Visitors won't see a compelling reason to click your link over competitors.

Why it matters for your business: Tag pages with weak or missing descriptions get lower click-through rates

from search results, reducing organic traffic to your content and product discovery.

Technical root cause: WordPress is not automatically generating or you have not manually set meta

descriptions for tag archive pages. Most WordPress themes only apply meta descriptions to posts and product

pages by default, leaving tag/category archives unoptimized.

Recommended fix — step by step

1. Install the Yoast SEO plugin (free version) if not already active: Dashboard → Plugins → Add New → search

'Yoast SEO' → Install and Activate

2. Go to Yoast SEO → Titles & Metas → Archives tab

3. Find the 'Tags' section and enable the toggle for 'Show tags in search results'

4. In the 'Meta description template for tags' field, enter: %%title%% | Premium cannabis products at Liberty

Buds NYC. Shop relaxation strains & more. Age 21+.

5. Click 'Save changes'

6. Verify the change: visit https://libertybudsnyc.com/tag/post-work-relaxation/ and check page source (Ctrl+F

'description') to confirm the meta tag is now present

58. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/thc-unwind/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page (for 'thc-unwind') doesn't have a meta description—the 50-160 character summary that appears

below your page title in Google search results. Without one, Google generates a random excerpt from your page

content, which often looks unprofessional and doesn't encourage clicks.

Why it matters for your business: Missing descriptions on tag pages reduce click-through rates from search

results, meaning fewer potential customers discover your products and content, directly impacting store traffic.

Technical root cause: WordPress tag pages typically auto-generate pages without custom meta descriptions.

Your theme or SEO plugin (if present) isn't filling this field automatically, leaving it blank.

https://libertybudsnyc.com/tag/post-work-relaxation/
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Recommended fix — step by step

1. Install or verify you have Yoast SEO or Rank Math active (free versions work fine)

2. Log in to WordPress → Tags → hover over 'thc-unwind' → click 'Quick Edit'

3. Scroll down to find the 'Meta Description' field (if using Yoast/Rank Math, it appears in the block editor

sidebar)

4. Write a 155-160 character description like: 'Discover THC Unwind products at Liberty Buds NYC. Premium

cannabis strains for relaxation. Browse our full selection and order online.'

5. Save the tag

6. Repeat for any other high-traffic tag pages (check Google Search Console → Performance → Queries tab to

identify them)

59. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://libertybudsnyc.com/tag/thc-for-insomnia/

Rule: tier2.meta.no-description

What it means (plain English)

Your tag page for 'THC for Insomnia' doesn't have a meta description—the short text snippet (usually 150–160

characters) that appears below your page title in Google search results. Without it, Google generates its own

summary, which often looks unprofessional and may not highlight your key selling points.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

customers see a generic or truncated preview instead of your message, losing potential foot traffic to

competitors with better search snippets.

Technical root cause: WordPress tag archives don't auto-generate meta descriptions by default. The tag page

was created without manually adding a description via an SEO plugin or by editing the theme template.

Recommended fix — step by step

1. Install Yoast SEO (free) if not already active: WordPress Admin → Plugins → Add New → search 'Yoast SEO'

→ Install and Activate

2. Go to WordPress Admin → Posts → Tags, find 'THC for Insomnia', click Edit

3. Scroll to the Yoast SEO section at the bottom, find the 'Meta description' field

4. Write a custom description (e.g., 'Explore strains and products for THC-assisted sleep at Liberty Buds NYC.

Lab-tested cannabis for insomnia relief.') — keep it 150–160 characters

5. Click Update to save

6. Repeat for other high-traffic tag pages (check Google Search Console → Performance → Queries to find

which tags get impressions)

7. After 2 weeks, monitor in Google Search Console to confirm the new snippet appears in results

60. 14 image(s) missing alt text

Severity: P2

Page URL: https://libertybudsnyc.com/contact-us/

https://libertybudsnyc.com/tag/thc-for-insomnia/
https://libertybudsnyc.com/contact-us/


Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

61. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/legal-weed-nyc/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

62. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/cannabis-music-pairings/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

63. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/420-nyc/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

64. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/nyc-cannabis-events/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

65. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/nyc-dispensaries/

Rule: tier2.meta.no-description

https://libertybudsnyc.com/tag/legal-weed-nyc/
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Detail

Page has no meta description.

66. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/miley-cyrus-weed-fashion/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

67. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/social-cannabis-use/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

68. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/manhattan-culture/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

69. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/cbd-for-fitness/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

70. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/cannabis-for-athletes/

Rule: tier2.meta.no-description

Detail
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Page has no meta description.

71. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/cannabis-and-exercise/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

72. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/cannabis-gummies/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

73. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/nyc-edibles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

74. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/thc-chocolate/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

75. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/midtown-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.
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76. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/prerolls/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

77. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/nyc-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

78. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/behind-the-counter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

79. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/dispensary-operations/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

80. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/budtender-life/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://libertybudsnyc.com/tag/prerolls/
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81. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/cannabis-education/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

82. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/upper-east-side-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

83. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/nyc-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

84. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/upper-east-side-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

85. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/liberty-buds-nyc/

Rule: tier2.meta.no-description

Detail

Page has no meta description.
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86. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/liberty-buds/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

87. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/cannabis-community/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

88. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/pop-up-event/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

89. Missing meta description

Severity: P2

Page URL: https://libertybudsnyc.com/tag/one-year-anniversary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

90. 1 broken internal link(s)

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier2.links.broken

Detail

Broken internal links degrade UX + crawl equity.

https://libertybudsnyc.com/tag/liberty-buds/
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91. Layout shift (mobile): 0.117

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier3.cwv.cls-mobile

Detail

CLS 0.117 exceeds 0.05 target.

92. Missing core schema types: LocalBusiness

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier4.schema.missing-core

Detail

Every site should emit Organization + LocalBusiness + WebSite JSON-LD.

93. Missing security header: strict-transport-security

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier5.header.strict-transport-security

Detail

strict-transport-security not present on homepage response. Affects fortress score and CSP posture.

94. Missing security header: x-frame-options

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier5.header.x-frame-options

Detail

x-frame-options not present on homepage response. Affects fortress score and CSP posture.

95. Missing security header: content-security-policy

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier5.header.content-security-policy

Detail

content-security-policy not present on homepage response. Affects fortress score and CSP posture.

https://libertybudsnyc.com/
https://libertybudsnyc.com/
https://libertybudsnyc.com/
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96. 88 tap targets under 44px at mobile-320

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

97. 90 tap targets under 44px at mobile-375

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

98. 90 tap targets under 44px at mobile-414

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

99. 77 tap targets under 44px at tablet-768

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

100. Lighthouse perf (mobile): 65/100

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier8.lighthouse.perf-mobile

Detail

Score 65 is below target 85. See HTML report for details.

https://libertybudsnyc.com/
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101. Lighthouse bestPractices (mobile): 61/100

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier8.lighthouse.bestPractices-mobile

Detail

Score 61 is below target 90. See HTML report for details.

102. Lighthouse perf (desktop): 75/100

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier8.lighthouse.perf-desktop

Detail

Score 75 is below target 90. See HTML report for details.

103. A11y: Heading levels should only increase by one

Severity: P2

Page URL: https://libertybudsnyc.com/

Rule: tier9.a11y.heading-order

Detail

Ensure the order of headings is semantically correct

Impact: moderate

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/heading-order?application=playwright

P3 — 852 findings

1. robots.txt does not reference sitemap

Severity: P3

Page URL: https://libertybudsnyc.com/robots.txt

Rule: tier2.robots.no-sitemap

Detail

robots.txt should contain a Sitemap: directive pointing to the XML sitemap.

2. Missing OpenGraph metadata

https://libertybudsnyc.com/
https://libertybudsnyc.com/
https://libertybudsnyc.com/
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Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

3. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

4. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

5. Title length 77 chars

Severity: P3

Page URL: https://libertybudsnyc.com/breaking-myths-debunking-common-misconceptions-about-

cannabis/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Breaking Myths: Debunking Common Misconceptions about Cannabis |

Liberty Buds"

6. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/breaking-myths-debunking-common-misconceptions-about-

cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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7. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/breaking-myths-debunking-common-misconceptions-about-

cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

8. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/breaking-myths-debunking-common-misconceptions-about-

cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

9. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/choosing-the-right-edible-for-you/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

10. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/choosing-the-right-edible-for-you/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

11. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/choosing-the-right-edible-for-you/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/breaking-myths-debunking-common-misconceptions-about-cannabis/
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12. Title length 77 chars

Severity: P3

Page URL: https://libertybudsnyc.com/breaking-myths-debunking-common-misconceptions-about-

cannabis-2/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Breaking Myths: Debunking Common Misconceptions about Cannabis |

Liberty Buds"

13. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/breaking-myths-debunking-common-misconceptions-about-

cannabis-2/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

14. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/breaking-myths-debunking-common-misconceptions-about-

cannabis-2/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

15. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/breaking-myths-debunking-common-misconceptions-about-

cannabis-2/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

16. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/valentines-day-karaoke-night/

Rule: tier2.meta.no-og
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Detail

Page missing og:title and/or og:image.

17. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/valentines-day-karaoke-night/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

18. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/valentines-day-karaoke-night/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

19. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/kiva-confections-at-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

20. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/kiva-confections-at-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

21. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/kiva-confections-at-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail
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Images without alt fail a11y + hurt SEO.

22. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/pax-instore-at-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

23. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/pax-instore-at-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

24. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/pax-instore-at-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

25. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/celebrate-4th-of-july-at-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

26. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/celebrate-4th-of-july-at-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/pax-instore-at-liberty-buds/
https://libertybudsnyc.com/pax-instore-at-liberty-buds/
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27. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/celebrate-4th-of-july-at-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

28. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/happy-fathers-day/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

29. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/happy-fathers-day/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

30. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/happy-fathers-day/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

31. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/join-us-for-4-20/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/celebrate-4th-of-july-at-liberty-buds/
https://libertybudsnyc.com/happy-fathers-day/
https://libertybudsnyc.com/happy-fathers-day/
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https://libertybudsnyc.com/join-us-for-4-20/


32. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/join-us-for-4-20/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

33. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/join-us-for-4-20/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

34. Title length 85 chars

Severity: P3

Page URL: https://libertybudsnyc.com/get-spooky-with-dank-at-liberty-buds-halloween-pre-roll-

celebration/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Get Spooky with Dank at Liberty Buds – Halloween Pre-Roll Celebration! |

Liberty Buds"

35. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/get-spooky-with-dank-at-liberty-buds-halloween-pre-roll-

celebration/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

36. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/get-spooky-with-dank-at-liberty-buds-halloween-pre-roll-

celebration/

Rule: tier2.meta.no-twitter-card

Detail

https://libertybudsnyc.com/join-us-for-4-20/
https://libertybudsnyc.com/join-us-for-4-20/
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https://libertybudsnyc.com/get-spooky-with-dank-at-liberty-buds-halloween-pre-roll-celebration/
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No twitter:card meta tag.

37. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/get-spooky-with-dank-at-liberty-buds-halloween-pre-roll-

celebration/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

38. Title length 74 chars

Severity: P3

Page URL: https://libertybudsnyc.com/celebrities-who-use-cannabis/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "7 Celebrities Who Use Cannabis: NYC Guide from Liberty Buds | Liberty

Buds"

39. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/celebrities-who-use-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

40. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/celebrities-who-use-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

41. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/celebrities-who-use-cannabis/

Rule: tier2.a11y.img-missing-alt

https://libertybudsnyc.com/get-spooky-with-dank-at-liberty-buds-halloween-pre-roll-celebration/
https://libertybudsnyc.com/get-spooky-with-dank-at-liberty-buds-halloween-pre-roll-celebration/
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Detail

Images without alt fail a11y + hurt SEO.

42. Title length 91 chars

Severity: P3

Page URL: https://libertybudsnyc.com/upper-east-side-dispensary-things-to-do/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Upper East Side Dispensary: 5 Chill Things to Do After Visiting Liberty Buds |

Liberty Buds"

43. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/upper-east-side-dispensary-things-to-do/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

44. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/upper-east-side-dispensary-things-to-do/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

45. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/upper-east-side-dispensary-things-to-do/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

46. Title length 132 chars

Severity: P3

Page URL: https://libertybudsnyc.com/riding-subway-high-upper-east-side-cannabis-dispensary/

Rule: tier2.meta.title-length

https://libertybudsnyc.com/upper-east-side-dispensary-things-to-do/
https://libertybudsnyc.com/upper-east-side-dispensary-things-to-do/
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Detail

Title should be 20-65 chars. Got: "A True Tale from Your Upper East Side Cannabis Dispensary ; What Happens

When I Ride the NYC Subway High for a Month? | Liberty Buds"

47. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/riding-subway-high-upper-east-side-cannabis-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

48. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/riding-subway-high-upper-east-side-cannabis-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

49. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/riding-subway-high-upper-east-side-cannabis-dispensary/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

50. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/best-cannabis-music-pairings-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

51. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/best-cannabis-music-pairings-liberty-buds/

Rule: tier2.meta.no-twitter-card

https://libertybudsnyc.com/riding-subway-high-upper-east-side-cannabis-dispensary/
https://libertybudsnyc.com/riding-subway-high-upper-east-side-cannabis-dispensary/
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Detail

No twitter:card meta tag.

52. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/best-cannabis-music-pairings-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

53. Title length 67 chars

Severity: P3

Page URL: https://libertybudsnyc.com/420-weekend-nyc-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "420 Weekend NYC: Best Things to Do from Liberty Buds | Liberty Buds"

54. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/420-weekend-nyc-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

55. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/420-weekend-nyc-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

56. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/420-weekend-nyc-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

https://libertybudsnyc.com/best-cannabis-music-pairings-liberty-buds/
https://libertybudsnyc.com/420-weekend-nyc-liberty-buds/
https://libertybudsnyc.com/420-weekend-nyc-liberty-buds/
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Images without alt fail a11y + hurt SEO.

57. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/miley-cyrus-weed-fashion-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

58. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/miley-cyrus-weed-fashion-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

59. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/miley-cyrus-weed-fashion-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

60. Title length 66 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-memorial-day-bbq/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "7 Chill Ways to Enjoy Cannabis for Memorial Day BBQ | Liberty Buds"

61. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-memorial-day-bbq/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/miley-cyrus-weed-fashion-liberty-buds/
https://libertybudsnyc.com/miley-cyrus-weed-fashion-liberty-buds/
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62. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-memorial-day-bbq/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

63. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-memorial-day-bbq/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

64. Title length 93 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-delivery-near-me/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis Delivery Near Me: How to Get Top-Shelf Weed Without Leaving the

Couch | Liberty Buds"

65. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-delivery-near-me/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

66. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-delivery-near-me/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/cannabis-for-memorial-day-bbq/
https://libertybudsnyc.com/cannabis-for-memorial-day-bbq/
https://libertybudsnyc.com/cannabis-delivery-near-me/
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67. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-delivery-near-me/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

68. Title length 89 chars

Severity: P3

Page URL: https://libertybudsnyc.com/upper-east-side-cannabis-dispensary-guide/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "5 High-End Cultural Pairings from Your Upper East Side Cannabis Dispensary

| Liberty Buds"

69. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/upper-east-side-cannabis-dispensary-guide/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

70. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/upper-east-side-cannabis-dispensary-guide/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

71. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/upper-east-side-cannabis-dispensary-guide/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/cannabis-delivery-near-me/
https://libertybudsnyc.com/upper-east-side-cannabis-dispensary-guide/
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72. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-cinco-de-mayo/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

73. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-cinco-de-mayo/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

74. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-cinco-de-mayo/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

75. Title length 71 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-drinks-worth-it/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Are Cannabis Drinks Worth It? A Budtender Breaks It Down | Liberty Buds"

76. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-drinks-worth-it/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/cannabis-for-cinco-de-mayo/
https://libertybudsnyc.com/cannabis-for-cinco-de-mayo/
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https://libertybudsnyc.com/cannabis-drinks-worth-it/


77. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-drinks-worth-it/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

78. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-drinks-worth-it/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

79. Title length 70 chars

Severity: P3

Page URL: https://libertybudsnyc.com/thc-label-guide/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "THC Label Guide: How to Read Cannabis Labels Like a Pro | Liberty Buds"

80. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/thc-label-guide/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

81. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/thc-label-guide/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/cannabis-drinks-worth-it/
https://libertybudsnyc.com/cannabis-drinks-worth-it/
https://libertybudsnyc.com/thc-label-guide/
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82. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/thc-label-guide/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

83. Title length 72 chars

Severity: P3

Page URL: https://libertybudsnyc.com/live-resin-vs-distillate/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Live Resin vs Distillate: Which Extract Is Right for You? | Liberty Buds"

84. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/live-resin-vs-distillate/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

85. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/live-resin-vs-distillate/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

86. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/live-resin-vs-distillate/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/thc-label-guide/
https://libertybudsnyc.com/live-resin-vs-distillate/
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87. Title length 84 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-delivery-roosevelt-island-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis Delivery Roosevelt Island: Liberty Buds Is Just Minutes Away |

Liberty Buds"

88. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-delivery-roosevelt-island-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

89. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-delivery-roosevelt-island-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

90. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-delivery-roosevelt-island-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

91. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-mothers-day/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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92. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-mothers-day/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

93. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-mothers-day/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

94. Title length 77 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-stress-relief-nyc-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "How Busy New Yorkers Use Cannabis for Stress Relief After Work | Liberty

Buds"

95. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-stress-relief-nyc-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

96. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-stress-relief-nyc-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/cannabis-for-mothers-day/
https://libertybudsnyc.com/cannabis-for-mothers-day/
https://libertybudsnyc.com/cannabis-for-stress-relief-nyc-liberty-buds/
https://libertybudsnyc.com/cannabis-for-stress-relief-nyc-liberty-buds/
https://libertybudsnyc.com/cannabis-for-stress-relief-nyc-liberty-buds/


97. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-stress-relief-nyc-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

98. Title length 68 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-sleep-nyc-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Best Cannabis for Sleep: NYC Budtenders Top Picks | Liberty Buds"

99. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-sleep-nyc-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

100. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-sleep-nyc-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

101. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-sleep-nyc-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/cannabis-for-stress-relief-nyc-liberty-buds/
https://libertybudsnyc.com/cannabis-for-sleep-nyc-liberty-buds/
https://libertybudsnyc.com/cannabis-for-sleep-nyc-liberty-buds/
https://libertybudsnyc.com/cannabis-for-sleep-nyc-liberty-buds/
https://libertybudsnyc.com/cannabis-for-sleep-nyc-liberty-buds/


102. Title length 80 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-athletes-nyc-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "How Active New Yorkers Use Cannabis for Athletes to Stay Balanced | Liberty

Buds"

103. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-athletes-nyc-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

104. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-athletes-nyc-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

105. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-for-athletes-nyc-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

106. Title length 84 chars

Severity: P3

Page URL: https://libertybudsnyc.com/best-edibles-in-nyc/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Best Edibles in NYC: What Liberty Buds Customers Are Loving Right Now |

Liberty Buds"

https://libertybudsnyc.com/cannabis-for-athletes-nyc-liberty-buds/
https://libertybudsnyc.com/cannabis-for-athletes-nyc-liberty-buds/
https://libertybudsnyc.com/cannabis-for-athletes-nyc-liberty-buds/
https://libertybudsnyc.com/cannabis-for-athletes-nyc-liberty-buds/
https://libertybudsnyc.com/best-edibles-in-nyc/


107. Description length 188 chars

Severity: P3

Page URL: https://libertybudsnyc.com/best-edibles-in-nyc/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

108. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/best-edibles-in-nyc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

109. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/best-edibles-in-nyc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

110. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/best-edibles-in-nyc/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

111. Title length 80 chars

Severity: P3

Page URL: https://libertybudsnyc.com/closest-dispensary-ues-shop-fast-legal-cannabis-at-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Closest Dispensary UES: Shop Fast, Legal Cannabis at Liberty Buds | Liberty

Buds"

https://libertybudsnyc.com/best-edibles-in-nyc/
https://libertybudsnyc.com/best-edibles-in-nyc/
https://libertybudsnyc.com/best-edibles-in-nyc/
https://libertybudsnyc.com/best-edibles-in-nyc/
https://libertybudsnyc.com/closest-dispensary-ues-shop-fast-legal-cannabis-at-liberty-buds/


112. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/closest-dispensary-ues-shop-fast-legal-cannabis-at-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

113. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/closest-dispensary-ues-shop-fast-legal-cannabis-at-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

114. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/closest-dispensary-ues-shop-fast-legal-cannabis-at-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

115. Title length 80 chars

Severity: P3

Page URL: https://libertybudsnyc.com/pre-rolls-upper-east-side-find-top-shelf-options-at-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Pre-Rolls Upper East Side: Find Top-Shelf Options at Liberty Buds | Liberty

Buds"

116. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/pre-rolls-upper-east-side-find-top-shelf-options-at-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/closest-dispensary-ues-shop-fast-legal-cannabis-at-liberty-buds/
https://libertybudsnyc.com/closest-dispensary-ues-shop-fast-legal-cannabis-at-liberty-buds/
https://libertybudsnyc.com/closest-dispensary-ues-shop-fast-legal-cannabis-at-liberty-buds/
https://libertybudsnyc.com/pre-rolls-upper-east-side-find-top-shelf-options-at-liberty-buds/
https://libertybudsnyc.com/pre-rolls-upper-east-side-find-top-shelf-options-at-liberty-buds/


117. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/pre-rolls-upper-east-side-find-top-shelf-options-at-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

118. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/pre-rolls-upper-east-side-find-top-shelf-options-at-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

119. Title length 69 chars

Severity: P3

Page URL: https://libertybudsnyc.com/libertybudsnyc-com-weed-pickup-upper-east-side/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Weed Pickup Upper East Side at Liberty Buds Dispensary | Liberty Buds"

120. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/libertybudsnyc-com-weed-pickup-upper-east-side/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

121. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/libertybudsnyc-com-weed-pickup-upper-east-side/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/pre-rolls-upper-east-side-find-top-shelf-options-at-liberty-buds/
https://libertybudsnyc.com/pre-rolls-upper-east-side-find-top-shelf-options-at-liberty-buds/
https://libertybudsnyc.com/libertybudsnyc-com-weed-pickup-upper-east-side/
https://libertybudsnyc.com/libertybudsnyc-com-weed-pickup-upper-east-side/
https://libertybudsnyc.com/libertybudsnyc-com-weed-pickup-upper-east-side/


122. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/libertybudsnyc-com-weed-pickup-upper-east-side/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

123. Title length 76 chars

Severity: P3

Page URL: https://libertybudsnyc.com/libertybudsnyc-com-best-dispensary-near-me/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Best Dispensary Near Me: Why Liberty Buds Is NYC’s Top Choice | Liberty

Buds"

124. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/libertybudsnyc-com-best-dispensary-near-me/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

125. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/libertybudsnyc-com-best-dispensary-near-me/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

126. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/libertybudsnyc-com-best-dispensary-near-me/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/libertybudsnyc-com-weed-pickup-upper-east-side/
https://libertybudsnyc.com/libertybudsnyc-com-best-dispensary-near-me/
https://libertybudsnyc.com/libertybudsnyc-com-best-dispensary-near-me/
https://libertybudsnyc.com/libertybudsnyc-com-best-dispensary-near-me/
https://libertybudsnyc.com/libertybudsnyc-com-best-dispensary-near-me/


127. Title length 98 chars

Severity: P3

Page URL: https://libertybudsnyc.com/dispensary-upper-east-side-nyc-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Recreational Dispensary Upper East Side: 5 Reasons Liberty Buds Is NYC’s

Top Choice | Liberty Buds"

128. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/dispensary-upper-east-side-nyc-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

129. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/dispensary-upper-east-side-nyc-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

130. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/dispensary-upper-east-side-nyc-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

131. Title length 75 chars

Severity: P3

Page URL: https://libertybudsnyc.com/nba-stars-who-support-cannabis/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "From Courtside to Cloud Nine: NBA Stars Who Support Cannabis | Liberty

Buds"

https://libertybudsnyc.com/dispensary-upper-east-side-nyc-liberty-buds/
https://libertybudsnyc.com/dispensary-upper-east-side-nyc-liberty-buds/
https://libertybudsnyc.com/dispensary-upper-east-side-nyc-liberty-buds/
https://libertybudsnyc.com/dispensary-upper-east-side-nyc-liberty-buds/
https://libertybudsnyc.com/nba-stars-who-support-cannabis/


132. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/nba-stars-who-support-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

133. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/nba-stars-who-support-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

134. 4 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/nba-stars-who-support-cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

135. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/can-you-smoke-and-still-be-productive/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

136. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/can-you-smoke-and-still-be-productive/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/nba-stars-who-support-cannabis/
https://libertybudsnyc.com/nba-stars-who-support-cannabis/
https://libertybudsnyc.com/nba-stars-who-support-cannabis/
https://libertybudsnyc.com/can-you-smoke-and-still-be-productive/
https://libertybudsnyc.com/can-you-smoke-and-still-be-productive/


137. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/can-you-smoke-and-still-be-productive/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

138. Title length 77 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-skincare-beauty-trends/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis Skincare: 7 Ways Weed Is Changing the Beauty Industry | Liberty

Buds"

139. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-skincare-beauty-trends/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

140. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-skincare-beauty-trends/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

141. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-skincare-beauty-trends/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/can-you-smoke-and-still-be-productive/
https://libertybudsnyc.com/cannabis-skincare-beauty-trends/
https://libertybudsnyc.com/cannabis-skincare-beauty-trends/
https://libertybudsnyc.com/cannabis-skincare-beauty-trends/
https://libertybudsnyc.com/cannabis-skincare-beauty-trends/


142. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/weed-shop-near-me-liberty-buds-midtown-east/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

143. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/weed-shop-near-me-liberty-buds-midtown-east/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

144. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/weed-shop-near-me-liberty-buds-midtown-east/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

145. Title length 85 chars

Severity: P3

Page URL: https://libertybudsnyc.com/best-dispensary-upper-east-side-nyc/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Buy Weed Upper East Side: Where to Shop Legal Cannabis at Liberty Buds |

Liberty Buds"

146. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/best-dispensary-upper-east-side-nyc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/weed-shop-near-me-liberty-buds-midtown-east/
https://libertybudsnyc.com/weed-shop-near-me-liberty-buds-midtown-east/
https://libertybudsnyc.com/weed-shop-near-me-liberty-buds-midtown-east/
https://libertybudsnyc.com/best-dispensary-upper-east-side-nyc/
https://libertybudsnyc.com/best-dispensary-upper-east-side-nyc/


147. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/best-dispensary-upper-east-side-nyc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

148. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/best-dispensary-upper-east-side-nyc/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

149. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/edibles-brands-changing-the-cannabis-game/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

150. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/edibles-brands-changing-the-cannabis-game/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

151. 4 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/edibles-brands-changing-the-cannabis-game/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/best-dispensary-upper-east-side-nyc/
https://libertybudsnyc.com/best-dispensary-upper-east-side-nyc/
https://libertybudsnyc.com/edibles-brands-changing-the-cannabis-game/
https://libertybudsnyc.com/edibles-brands-changing-the-cannabis-game/
https://libertybudsnyc.com/edibles-brands-changing-the-cannabis-game/


152. Title length 97 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-and-concerts-summer/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Summer of Eras: Why Every Artist Has a Tour (and Why You’re Smoking

Before It) | Liberty Buds"

153. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-and-concerts-summer/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

154. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-and-concerts-summer/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

155. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-and-concerts-summer/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

156. Title length 96 chars

Severity: P3

Page URL: https://libertybudsnyc.com/behind-the-counter-liberty-buds-ues/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "What Happens Behind the Counter at Your Local Dispensary? Inside Liberty

Buds NYC | Liberty Buds"

https://libertybudsnyc.com/cannabis-and-concerts-summer/
https://libertybudsnyc.com/cannabis-and-concerts-summer/
https://libertybudsnyc.com/cannabis-and-concerts-summer/
https://libertybudsnyc.com/cannabis-and-concerts-summer/
https://libertybudsnyc.com/behind-the-counter-liberty-buds-ues/


157. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/behind-the-counter-liberty-buds-ues/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

158. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/behind-the-counter-liberty-buds-ues/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

159. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/behind-the-counter-liberty-buds-ues/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

160. Title length 78 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-meets-fashion-streetwear/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "High Fashion: How Cannabis Took Over Pop Culture and Streetwear | Liberty

Buds"

161. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-meets-fashion-streetwear/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/behind-the-counter-liberty-buds-ues/
https://libertybudsnyc.com/behind-the-counter-liberty-buds-ues/
https://libertybudsnyc.com/behind-the-counter-liberty-buds-ues/
https://libertybudsnyc.com/cannabis-meets-fashion-streetwear/
https://libertybudsnyc.com/cannabis-meets-fashion-streetwear/


162. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-meets-fashion-streetwear/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

163. 2 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-meets-fashion-streetwear/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

164. Title length 79 chars

Severity: P3

Page URL: https://libertybudsnyc.com/vape-cartridges-roosevelt-island/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Vape Cartridges Roosevelt Island Shoppers Love from Liberty Buds | Liberty

Buds"

165. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/vape-cartridges-roosevelt-island/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

166. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/vape-cartridges-roosevelt-island/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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167. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/vape-cartridges-roosevelt-island/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

168. Title length 89 chars

Severity: P3

Page URL: https://libertybudsnyc.com/barbiecore-birkenstocks-blunts-summer-style/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Barbiecore, Birkenstocks, and Blunts: What Summer 2025 Style Says About

Us | Liberty Buds"

169. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/barbiecore-birkenstocks-blunts-summer-style/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

170. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/barbiecore-birkenstocks-blunts-summer-style/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

171. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/barbiecore-birkenstocks-blunts-summer-style/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/vape-cartridges-roosevelt-island/
https://libertybudsnyc.com/barbiecore-birkenstocks-blunts-summer-style/
https://libertybudsnyc.com/barbiecore-birkenstocks-blunts-summer-style/
https://libertybudsnyc.com/barbiecore-birkenstocks-blunts-summer-style/
https://libertybudsnyc.com/barbiecore-birkenstocks-blunts-summer-style/


172. Title length 88 chars

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-best-dispensary-nyc/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Trusted Cannabis Dispensary NYC: 5 Reasons Liberty Buds is the Top Choice

| Liberty Buds"

173. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-best-dispensary-nyc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

174. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-best-dispensary-nyc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

175. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-best-dispensary-nyc/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

176. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/1-year-anniversary-at-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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177. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/1-year-anniversary-at-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

178. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/1-year-anniversary-at-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

179. Title length 70 chars

Severity: P3

Page URL: https://libertybudsnyc.com/minor-cannabinoids/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Beyond THC and CBD: Minor Cannabinoids You Need to Know | Liberty Buds"

180. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/minor-cannabinoids/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

181. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/minor-cannabinoids/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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182. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/minor-cannabinoids/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

183. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-and-creativity/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

184. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-and-creativity/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

185. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-and-creativity/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

186. Title length 78 chars

Severity: P3

Page URL: https://libertybudsnyc.com/rolling-rituals-joints-around-the-world/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Rolling Rituals: The Art and Culture of Joints Around the World | Liberty

Buds"
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187. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/rolling-rituals-joints-around-the-world/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

188. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/rolling-rituals-joints-around-the-world/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

189. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/rolling-rituals-joints-around-the-world/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

190. Title length 82 chars

Severity: P3

Page URL: https://libertybudsnyc.com/movie-characters-smoking-cool/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "High Fashion Icons: The Movie Characters Who Made Smoking Look Cool |

Liberty Buds"

191. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/movie-characters-smoking-cool/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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192. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/movie-characters-smoking-cool/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

193. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/movie-characters-smoking-cool/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

194. Title length 82 chars

Severity: P3

Page URL: https://libertybudsnyc.com/nyc-spots-cannabis-culture/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "From Central Park to Rooftops: The Best NYC Spots to Enjoy Cannabis |

Liberty Buds"

195. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/nyc-spots-cannabis-culture/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

196. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/nyc-spots-cannabis-culture/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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197. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/nyc-spots-cannabis-culture/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

198. Title length 69 chars

Severity: P3

Page URL: https://libertybudsnyc.com/us-open-2025-tennis-cannabis-culture/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Courtside Clouds: Cannabis Culture Meets the U.S. Open | Liberty Buds"

199. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/us-open-2025-tennis-cannabis-culture/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

200. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/us-open-2025-tennis-cannabis-culture/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

201. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/us-open-2025-tennis-cannabis-culture/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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202. Title length 95 chars

Severity: P3

Page URL: https://libertybudsnyc.com/e-sports-irl/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "E Sports IRL: Why Fortnite, League, and Rocket League Aren’t Just Online

Anymore | Liberty Buds"

203. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/e-sports-irl/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

204. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/e-sports-irl/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

205. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/e-sports-irl/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

206. Title length 69 chars

Severity: P3

Page URL: https://libertybudsnyc.com/venice-film-festival-2025/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Why Everyone is Talking About the Venice Film Festival | Liberty Buds"

https://libertybudsnyc.com/e-sports-irl/
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207. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/venice-film-festival-2025/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

208. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/venice-film-festival-2025/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

209. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/venice-film-festival-2025/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

210. Title length 106 chars

Severity: P3

Page URL: https://libertybudsnyc.com/new-york-immersive-museums/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "New York’s Museum Boom: Why Immersive Exhibits Are the City’s Hottest

Ticket | Liberty Buds | Liberty Buds"

211. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/new-york-immersive-museums/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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212. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/new-york-immersive-museums/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

213. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/new-york-immersive-museums/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

214. Title length 91 chars

Severity: P3

Page URL: https://libertybudsnyc.com/nyc-street-murals/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "NYC Street Murals: How Artists Are Turning the City Into an Open Air Gallery

| Liberty Buds"

215. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/nyc-street-murals/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

216. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/nyc-street-murals/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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217. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/nyc-street-murals/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

218. Title length 101 chars

Severity: P3

Page URL: https://libertybudsnyc.com/podcast-power-nyc/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Podcast Power: The Shows Everyone in New York Is Listening to Right Now |

Liberty Buds | Liberty Buds"

219. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/podcast-power-nyc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

220. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/podcast-power-nyc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

221. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/podcast-power-nyc/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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222. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/upper-east-side-cannabis-culture/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

223. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/upper-east-side-cannabis-culture/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

224. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/upper-east-side-cannabis-culture/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

225. Title length 82 chars

Severity: P3

Page URL: https://libertybudsnyc.com/seasons-of-the-high-cannabis-rituals/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Seasons of the High: How Weather and Time of Year Shape Our Rituals |

Liberty Buds"

226. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/seasons-of-the-high-cannabis-rituals/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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227. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/seasons-of-the-high-cannabis-rituals/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

228. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/seasons-of-the-high-cannabis-rituals/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

229. Title length 75 chars

Severity: P3

Page URL: https://libertybudsnyc.com/high-tech-cannabis-innovation/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "High-Tech Highs: How Innovation is Changing the Way We Smoke | Liberty

Buds"

230. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/high-tech-cannabis-innovation/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

231. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/high-tech-cannabis-innovation/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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232. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/high-tech-cannabis-innovation/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

233. Title length 85 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-and-the-senses/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis and the Senses: Why Smell, Taste, and Sound Feel More Intense |

Liberty Buds"

234. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-and-the-senses/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

235. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-and-the-senses/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

236. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-and-the-senses/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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237. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/modern-rituals-daily-meaning/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

238. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/modern-rituals-daily-meaning/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

239. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/modern-rituals-daily-meaning/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

240. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cozy-autumn-strains-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

241. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cozy-autumn-strains-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/modern-rituals-daily-meaning/
https://libertybudsnyc.com/modern-rituals-daily-meaning/
https://libertybudsnyc.com/modern-rituals-daily-meaning/
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242. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cozy-autumn-strains-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

243. Title length 75 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-crisp-nyc-nights/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Warming Up with Cannabis: Perfect Picks for Crisp NYC Nights | Liberty

Buds"

244. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-crisp-nyc-nights/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

245. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-crisp-nyc-nights/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

246. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-crisp-nyc-nights/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/cozy-autumn-strains-liberty-buds/
https://libertybudsnyc.com/cannabis-crisp-nyc-nights/
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247. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-infused-fall-recipes-nyc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

248. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-infused-fall-recipes-nyc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

249. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-infused-fall-recipes-nyc/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

250. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/hidden-jazz-spots-nyc-fall-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

251. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/hidden-jazz-spots-nyc-fall-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/cannabis-infused-fall-recipes-nyc/
https://libertybudsnyc.com/cannabis-infused-fall-recipes-nyc/
https://libertybudsnyc.com/cannabis-infused-fall-recipes-nyc/
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https://libertybudsnyc.com/hidden-jazz-spots-nyc-fall-liberty-buds/


252. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/hidden-jazz-spots-nyc-fall-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

253. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-strains-october/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

254. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-strains-october/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

255. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-strains-october/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

256. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/autumn-cannabis-flavors-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/hidden-jazz-spots-nyc-fall-liberty-buds/
https://libertybudsnyc.com/liberty-buds-strains-october/
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257. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/autumn-cannabis-flavors-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

258. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/autumn-cannabis-flavors-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

259. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/happy-effect-cannabis-products-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

260. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/happy-effect-cannabis-products-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

261. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/happy-effect-cannabis-products-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/autumn-cannabis-flavors-liberty-buds/
https://libertybudsnyc.com/autumn-cannabis-flavors-liberty-buds/
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262. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/fall-cannabis-recipes-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

263. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/fall-cannabis-recipes-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

264. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/fall-cannabis-recipes-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

265. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/fall-wine-and-weed-pairings/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

266. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/fall-wine-and-weed-pairings/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/fall-cannabis-recipes-liberty-buds/
https://libertybudsnyc.com/fall-cannabis-recipes-liberty-buds/
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267. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/fall-wine-and-weed-pairings/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

268. Title length 73 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-harvest-season-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "From Harvest to High: Why Fall Defines the Cannabis Season | Liberty Buds"

269. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-harvest-season-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

270. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-harvest-season-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

271. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-harvest-season-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/fall-wine-and-weed-pairings/
https://libertybudsnyc.com/cannabis-harvest-season-liberty-buds/
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272. Title length 83 chars

Severity: P3

Page URL: https://libertybudsnyc.com/vapes-for-every-mood-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Vapes for Every Mood: Finding Your Perfect Cartridge at Liberty Buds |

Liberty Buds"

273. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/vapes-for-every-mood-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

274. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/vapes-for-every-mood-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

275. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/vapes-for-every-mood-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

276. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/beat-the-fall-slump-with-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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277. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/beat-the-fall-slump-with-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

278. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/beat-the-fall-slump-with-cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

279. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/top-hybrid-picks-for-the-weekend/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

280. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/top-hybrid-picks-for-the-weekend/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

281. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/top-hybrid-picks-for-the-weekend/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/beat-the-fall-slump-with-cannabis/
https://libertybudsnyc.com/beat-the-fall-slump-with-cannabis/
https://libertybudsnyc.com/top-hybrid-picks-for-the-weekend/
https://libertybudsnyc.com/top-hybrid-picks-for-the-weekend/
https://libertybudsnyc.com/top-hybrid-picks-for-the-weekend/


282. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/ayrloom-fall-favorites/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

283. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/ayrloom-fall-favorites/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

284. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/ayrloom-fall-favorites/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

285. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/dank-by-definition-fall-picks/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

286. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/dank-by-definition-fall-picks/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/ayrloom-fall-favorites/
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https://libertybudsnyc.com/dank-by-definition-fall-picks/


287. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/dank-by-definition-fall-picks/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

288. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/bouket-premium-flower-fall/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

289. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/bouket-premium-flower-fall/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

290. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/bouket-premium-flower-fall/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

291. Title length 72 chars

Severity: P3

Page URL: https://libertybudsnyc.com/halloween-vapes-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "🕸️  Vape & Vanish: Halloween Vapes That Disappear Quickly | Liberty Buds"

https://libertybudsnyc.com/dank-by-definition-fall-picks/
https://libertybudsnyc.com/bouket-premium-flower-fall/
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292. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/halloween-vapes-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

293. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/halloween-vapes-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

294. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/halloween-vapes-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

295. Title length 77 chars

Severity: P3

Page URL: https://libertybudsnyc.com/halloween-strains-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "🎃  Trick or Terps: Liberty Buds’ Frightfully Flavorful Strains | Liberty Buds"

296. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/halloween-strains-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/halloween-vapes-liberty-buds/
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297. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/halloween-strains-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

298. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/halloween-strains-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

299. Title length 71 chars

Severity: P3

Page URL: https://libertybudsnyc.com/halloween-hybrids-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "🎃  Smoke and Spells: The Magic of Hybrids This Halloween | Liberty Buds"

300. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/halloween-hybrids-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

301. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/halloween-hybrids-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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302. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/halloween-hybrids-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

303. Title length 75 chars

Severity: P3

Page URL: https://libertybudsnyc.com/gratitude-cannabis-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "💚  Gratitude in Every Puff: Finding Calm Before the Holidays | Liberty Buds"

304. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/gratitude-cannabis-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

305. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/gratitude-cannabis-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

306. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/gratitude-cannabis-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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307. Title length 82 chars

Severity: P3

Page URL: https://libertybudsnyc.com/veterans-day-flower-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Gratitude in Bloom: Honoring Veterans Through Reflection and Flower |

Liberty Buds"

308. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/veterans-day-flower-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

309. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/veterans-day-flower-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

310. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/veterans-day-flower-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

311. Title length 78 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-gifts-liberty-buds/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "🎁  Gift of Green: Cannabis Gifting Guide for the Holiday Season | Liberty

Buds"
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312. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-gifts-liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

313. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-gifts-liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

314. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-gifts-liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

315. Title length 105 chars

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-nyc-service-areas-cannabis-delivery-to-manhattan-

queens-brooklyn-beyond/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Liberty Buds NYC Service Areas - Cannabis Delivery to Manhattan, Queens,

Brooklyn & Beyond | Liberty Buds"

316. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-nyc-service-areas-cannabis-delivery-to-manhattan-

queens-brooklyn-beyond/

Rule: tier2.meta.no-og

Detail

https://libertybudsnyc.com/cannabis-gifts-liberty-buds/
https://libertybudsnyc.com/cannabis-gifts-liberty-buds/
https://libertybudsnyc.com/cannabis-gifts-liberty-buds/
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Page missing og:title and/or og:image.

317. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-nyc-service-areas-cannabis-delivery-to-manhattan-

queens-brooklyn-beyond/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

318. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-nyc-service-areas-cannabis-delivery-to-manhattan-

queens-brooklyn-beyond/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

319. Title length 100 chars

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-same-day-cannabis-delivery-nyc-free-delivery-

aeropay-order-tracking/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Liberty Buds Same-Day Cannabis Delivery NYC - Free Delivery, Aeropay &

Order Tracking | Liberty Buds"

320. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-same-day-cannabis-delivery-nyc-free-delivery-

aeropay-order-tracking/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

321. Missing Twitter card

Severity: P3
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Page URL: https://libertybudsnyc.com/liberty-buds-same-day-cannabis-delivery-nyc-free-delivery-

aeropay-order-tracking/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

322. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-same-day-cannabis-delivery-nyc-free-delivery-

aeropay-order-tracking/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

323. Title length 96 chars

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-nyc-cannabis-menu-buy-flower-edibles-vapes-

concentrates-online/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Liberty Buds NYC Cannabis Menu - Buy Flower, Edibles, Vapes &

Concentrates Online | Liberty Buds"

324. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-nyc-cannabis-menu-buy-flower-edibles-vapes-

concentrates-online/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

325. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-nyc-cannabis-menu-buy-flower-edibles-vapes-

concentrates-online/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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https://libertybudsnyc.com/liberty-buds-same-day-cannabis-delivery-nyc-free-delivery-aeropay-order-tracking/
https://libertybudsnyc.com/liberty-buds-same-day-cannabis-delivery-nyc-free-delivery-aeropay-order-tracking/
https://libertybudsnyc.com/liberty-buds-same-day-cannabis-delivery-nyc-free-delivery-aeropay-order-tracking/
https://libertybudsnyc.com/liberty-buds-nyc-cannabis-menu-buy-flower-edibles-vapes-concentrates-online/
https://libertybudsnyc.com/liberty-buds-nyc-cannabis-menu-buy-flower-edibles-vapes-concentrates-online/
https://libertybudsnyc.com/liberty-buds-nyc-cannabis-menu-buy-flower-edibles-vapes-concentrates-online/
https://libertybudsnyc.com/liberty-buds-nyc-cannabis-menu-buy-flower-edibles-vapes-concentrates-online/
https://libertybudsnyc.com/liberty-buds-nyc-cannabis-menu-buy-flower-edibles-vapes-concentrates-online/
https://libertybudsnyc.com/liberty-buds-nyc-cannabis-menu-buy-flower-edibles-vapes-concentrates-online/


326. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/liberty-buds-nyc-cannabis-menu-buy-flower-edibles-vapes-

concentrates-online/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

327. Description length 12 chars

Severity: P3

Page URL: https://libertybudsnyc.com/confirmation/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

328. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/confirmation/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

329. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/confirmation/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

330. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/confirmation/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/liberty-buds-nyc-cannabis-menu-buy-flower-edibles-vapes-concentrates-online/
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331. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/specials/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

332. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/specials/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

333. 2 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/specials/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

334. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-midtown-east/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

335. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-midtown-east/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/specials/
https://libertybudsnyc.com/specials/
https://libertybudsnyc.com/specials/
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336. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-midtown-east/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

337. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-murray-hill/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

338. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-murray-hill/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

339. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-murray-hill/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

340. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-roosevelt-island/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/cannabis-dispensary-midtown-east/
https://libertybudsnyc.com/cannabis-dispensary-murray-hill/
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341. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-roosevelt-island/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

342. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-roosevelt-island/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

343. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-new-york-city/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

344. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-new-york-city/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

345. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-new-york-city/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/cannabis-dispensary-roosevelt-island/
https://libertybudsnyc.com/cannabis-dispensary-roosevelt-island/
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346. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-upper-east-side/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

347. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-upper-east-side/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

348. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-upper-east-side/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

349. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-manhattan/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

350. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-manhattan/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/cannabis-dispensary-upper-east-side/
https://libertybudsnyc.com/cannabis-dispensary-upper-east-side/
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351. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-manhattan/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

352. Description length 19 chars

Severity: P3

Page URL: https://libertybudsnyc.com/opt-out-preferences/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

353. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/opt-out-preferences/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

354. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/opt-out-preferences/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

355. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/opt-out-preferences/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/cannabis-dispensary-manhattan/
https://libertybudsnyc.com/opt-out-preferences/
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356. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/terms-of-use/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

357. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/terms-of-use/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

358. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/terms-of-use/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

359. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/accessibility-statement/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

360. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/accessibility-statement/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/terms-of-use/
https://libertybudsnyc.com/terms-of-use/
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361. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/accessibility-statement/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

362. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/homepage-horace-harding-location/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

363. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/homepage-horace-harding-location/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

364. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/homepage-horace-harding-location/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

365. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/events/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/accessibility-statement/
https://libertybudsnyc.com/homepage-horace-harding-location/
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366. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/events/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

367. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/events/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

368. Title length 18 chars

Severity: P3

Page URL: https://libertybudsnyc.com/faq/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "FAQ | Liberty Buds"

369. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/faq/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

370. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/faq/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/events/
https://libertybudsnyc.com/events/
https://libertybudsnyc.com/faq/
https://libertybudsnyc.com/faq/
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371. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/faq/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

372. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/press/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

373. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/press/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

374. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/press/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

375. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/gallery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/faq/
https://libertybudsnyc.com/press/
https://libertybudsnyc.com/press/
https://libertybudsnyc.com/press/
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376. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/gallery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

377. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/gallery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

378. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/vendors/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

379. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/vendors/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

380. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/vendors/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/gallery/
https://libertybudsnyc.com/gallery/
https://libertybudsnyc.com/vendors/
https://libertybudsnyc.com/vendors/
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381. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/privacy-policy/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

382. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/privacy-policy/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

383. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/privacy-policy/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

384. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-brands-queens-nassau/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

385. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-brands-queens-nassau/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/privacy-policy/
https://libertybudsnyc.com/privacy-policy/
https://libertybudsnyc.com/privacy-policy/
https://libertybudsnyc.com/cannabis-brands-queens-nassau/
https://libertybudsnyc.com/cannabis-brands-queens-nassau/


386. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-brands-queens-nassau/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

387. Description length 10 chars

Severity: P3

Page URL: https://libertybudsnyc.com/relaxation-cannabis/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

388. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/relaxation-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

389. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/relaxation-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

390. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/relaxation-cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/cannabis-brands-queens-nassau/
https://libertybudsnyc.com/relaxation-cannabis/
https://libertybudsnyc.com/relaxation-cannabis/
https://libertybudsnyc.com/relaxation-cannabis/
https://libertybudsnyc.com/relaxation-cannabis/


391. Description length 20 chars

Severity: P3

Page URL: https://libertybudsnyc.com/queens-shop/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

392. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/queens-shop/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

393. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/queens-shop/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

394. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/queens-shop/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

395. Description length 14 chars

Severity: P3

Page URL: https://libertybudsnyc.com/manhattan-shop/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

https://libertybudsnyc.com/queens-shop/
https://libertybudsnyc.com/queens-shop/
https://libertybudsnyc.com/queens-shop/
https://libertybudsnyc.com/queens-shop/
https://libertybudsnyc.com/manhattan-shop/


396. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/manhattan-shop/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

397. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/manhattan-shop/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

398. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/manhattan-shop/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

399. Description length 5 chars

Severity: P3

Page URL: https://libertybudsnyc.com/sleep/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

400. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/sleep/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/manhattan-shop/
https://libertybudsnyc.com/manhattan-shop/
https://libertybudsnyc.com/manhattan-shop/
https://libertybudsnyc.com/sleep/
https://libertybudsnyc.com/sleep/


401. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/sleep/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

402. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/sleep/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

403. Description length 5 chars

Severity: P3

Page URL: https://libertybudsnyc.com/happy/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

404. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/happy/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

405. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/happy/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/sleep/
https://libertybudsnyc.com/sleep/
https://libertybudsnyc.com/happy/
https://libertybudsnyc.com/happy/
https://libertybudsnyc.com/happy/


406. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/happy/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

407. Description length 9 chars

Severity: P3

Page URL: https://libertybudsnyc.com/energetic/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

408. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/energetic/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

409. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/energetic/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

410. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/energetic/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/happy/
https://libertybudsnyc.com/energetic/
https://libertybudsnyc.com/energetic/
https://libertybudsnyc.com/energetic/
https://libertybudsnyc.com/energetic/


411. Description length 8 chars

Severity: P3

Page URL: https://libertybudsnyc.com/creative/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

412. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/creative/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

413. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/creative/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

414. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/creative/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

415. Description length 9 chars

Severity: P3

Page URL: https://libertybudsnyc.com/top-shelf/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

https://libertybudsnyc.com/creative/
https://libertybudsnyc.com/creative/
https://libertybudsnyc.com/creative/
https://libertybudsnyc.com/creative/
https://libertybudsnyc.com/top-shelf/


416. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/top-shelf/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

417. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/top-shelf/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

418. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/top-shelf/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

419. Description length 18 chars

Severity: P3

Page URL: https://libertybudsnyc.com/wellness-manhattan/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

420. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/wellness-manhattan/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/top-shelf/
https://libertybudsnyc.com/top-shelf/
https://libertybudsnyc.com/top-shelf/
https://libertybudsnyc.com/wellness-manhattan/
https://libertybudsnyc.com/wellness-manhattan/


421. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/wellness-manhattan/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

422. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/wellness-manhattan/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

423. Description length 24 chars

Severity: P3

Page URL: https://libertybudsnyc.com/wellness-queens-nassau/

Rule: tier2.meta.description-length

Detail

Description should be 80-160 chars.

424. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/wellness-queens-nassau/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

425. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/wellness-queens-nassau/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/wellness-manhattan/
https://libertybudsnyc.com/wellness-manhattan/
https://libertybudsnyc.com/wellness-queens-nassau/
https://libertybudsnyc.com/wellness-queens-nassau/
https://libertybudsnyc.com/wellness-queens-nassau/


426. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/wellness-queens-nassau/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

427. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/homepage-update/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

428. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/homepage-update/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

429. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-brands-manhattan/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

430. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-brands-manhattan/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/wellness-queens-nassau/
https://libertybudsnyc.com/homepage-update/
https://libertybudsnyc.com/homepage-update/
https://libertybudsnyc.com/cannabis-brands-manhattan/
https://libertybudsnyc.com/cannabis-brands-manhattan/


431. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-brands-manhattan/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

432. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/community/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

433. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/community/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

434. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/community/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

435. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/contact-us/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/cannabis-brands-manhattan/
https://libertybudsnyc.com/community/
https://libertybudsnyc.com/community/
https://libertybudsnyc.com/community/
https://libertybudsnyc.com/contact-us/


436. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/contact-us/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

437. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/loyalty-program/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

438. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/loyalty-program/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

439. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/loyalty-program/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

440. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/delivery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/contact-us/
https://libertybudsnyc.com/loyalty-program/
https://libertybudsnyc.com/loyalty-program/
https://libertybudsnyc.com/loyalty-program/
https://libertybudsnyc.com/delivery/


441. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/delivery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

442. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/delivery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

443. Title length 67 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-new-york-city-2/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis Dispensary NYC — Liberty Buds Manhattan UES | Liberty Buds"

444. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-new-york-city-2/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

445. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-new-york-city-2/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/delivery/
https://libertybudsnyc.com/delivery/
https://libertybudsnyc.com/cannabis-dispensary-new-york-city-2/
https://libertybudsnyc.com/cannabis-dispensary-new-york-city-2/
https://libertybudsnyc.com/cannabis-dispensary-new-york-city-2/


446. 2 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-new-york-city-2/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

447. Title length 66 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-yorkville/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis Dispensary in Yorkville NYC — Liberty Buds | Liberty Buds"

448. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-yorkville/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

449. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-yorkville/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

450. 2 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-yorkville/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/cannabis-dispensary-new-york-city-2/
https://libertybudsnyc.com/cannabis-dispensary-yorkville/
https://libertybudsnyc.com/cannabis-dispensary-yorkville/
https://libertybudsnyc.com/cannabis-dispensary-yorkville/
https://libertybudsnyc.com/cannabis-dispensary-yorkville/


451. Title length 66 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-sutton-place/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis Dispensary Sutton Place NYC — Liberty Buds | Liberty Buds"

452. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-sutton-place/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

453. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-sutton-place/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

454. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-sutton-place/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

455. Title length 19 chars

Severity: P3

Page URL: https://libertybudsnyc.com/blog/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Blog | Liberty Buds"

https://libertybudsnyc.com/cannabis-dispensary-sutton-place/
https://libertybudsnyc.com/cannabis-dispensary-sutton-place/
https://libertybudsnyc.com/cannabis-dispensary-sutton-place/
https://libertybudsnyc.com/cannabis-dispensary-sutton-place/
https://libertybudsnyc.com/blog/


456. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/blog/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

457. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/blog/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

458. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/blog/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

459. Title length 67 chars

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-lenox-hill/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis Dispensary in Lenox Hill NYC — Liberty Buds | Liberty Buds"

460. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-lenox-hill/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/blog/
https://libertybudsnyc.com/blog/
https://libertybudsnyc.com/blog/
https://libertybudsnyc.com/cannabis-dispensary-lenox-hill/
https://libertybudsnyc.com/cannabis-dispensary-lenox-hill/


461. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-lenox-hill/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

462. 2 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-lenox-hill/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

463. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/about/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

464. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/about/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

465. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-queens-nassau/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/cannabis-dispensary-lenox-hill/
https://libertybudsnyc.com/cannabis-dispensary-lenox-hill/
https://libertybudsnyc.com/about/
https://libertybudsnyc.com/about/
https://libertybudsnyc.com/cannabis-dispensary-queens-nassau/


466. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/cannabis-dispensary-queens-nassau/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

467. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-loop-item

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

468. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-loop-item

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

469. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-loop-item

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

470. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=internal-page-template

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/cannabis-dispensary-queens-nassau/
https://libertybudsnyc.com/?elementor_library=elementor-loop-item
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471. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=internal-page-template

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

472. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=internal-page-template

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

473. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-single-page-3883

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

474. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-single-page-3883

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

475. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-single-page-3883

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/?elementor_library=internal-page-template
https://libertybudsnyc.com/?elementor_library=internal-page-template
https://libertybudsnyc.com/?elementor_library=elementor-single-page-3883
https://libertybudsnyc.com/?elementor_library=elementor-single-page-3883
https://libertybudsnyc.com/?elementor_library=elementor-single-page-3883


476. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-single-post-3884

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

477. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-single-post-3884

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

478. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-single-post-3884

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

479. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=updated-homepage

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

480. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=updated-homepage

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/?elementor_library=elementor-single-post-3884
https://libertybudsnyc.com/?elementor_library=elementor-single-post-3884
https://libertybudsnyc.com/?elementor_library=elementor-single-post-3884
https://libertybudsnyc.com/?elementor_library=updated-homepage
https://libertybudsnyc.com/?elementor_library=updated-homepage


481. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=updated-homepage

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

482. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=home

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

483. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=home

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

484. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=home

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

485. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=sliders

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/?elementor_library=updated-homepage
https://libertybudsnyc.com/?elementor_library=home
https://libertybudsnyc.com/?elementor_library=home
https://libertybudsnyc.com/?elementor_library=home
https://libertybudsnyc.com/?elementor_library=sliders


486. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=sliders

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

487. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=sliders

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

488. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=home-with-sliders

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

489. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=home-with-sliders

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

490. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=home-with-sliders

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/?elementor_library=sliders
https://libertybudsnyc.com/?elementor_library=sliders
https://libertybudsnyc.com/?elementor_library=home-with-sliders
https://libertybudsnyc.com/?elementor_library=home-with-sliders
https://libertybudsnyc.com/?elementor_library=home-with-sliders


491. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=lb-home

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

492. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=lb-home

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

493. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=lb-home

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

494. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=lb-slider

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

495. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=lb-slider

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/?elementor_library=lb-home
https://libertybudsnyc.com/?elementor_library=lb-home
https://libertybudsnyc.com/?elementor_library=lb-home
https://libertybudsnyc.com/?elementor_library=lb-slider
https://libertybudsnyc.com/?elementor_library=lb-slider


496. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=lb-slider

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

497. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-checker

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

498. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-checker

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

499. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-checker

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

500. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=skyline-bgs

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/?elementor_library=lb-slider
https://libertybudsnyc.com/?elementor_library=delivery-checker
https://libertybudsnyc.com/?elementor_library=delivery-checker
https://libertybudsnyc.com/?elementor_library=delivery-checker
https://libertybudsnyc.com/?elementor_library=skyline-bgs


501. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=skyline-bgs

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

502. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=skyline-bgs

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

503. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-homepage

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

504. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-homepage

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

505. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-homepage

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/?elementor_library=skyline-bgs
https://libertybudsnyc.com/?elementor_library=skyline-bgs
https://libertybudsnyc.com/?elementor_library=delivery-homepage
https://libertybudsnyc.com/?elementor_library=delivery-homepage
https://libertybudsnyc.com/?elementor_library=delivery-homepage


506. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=lb-video-homepage

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

507. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=lb-video-homepage

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

508. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=lb-video-homepage

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

509. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=home-with-delivery-tracker

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

510. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=home-with-delivery-tracker

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/?elementor_library=lb-video-homepage
https://libertybudsnyc.com/?elementor_library=lb-video-homepage
https://libertybudsnyc.com/?elementor_library=lb-video-homepage
https://libertybudsnyc.com/?elementor_library=home-with-delivery-tracker
https://libertybudsnyc.com/?elementor_library=home-with-delivery-tracker


511. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=home-with-delivery-tracker

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

512. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=live-homepage

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

513. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=live-homepage

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

514. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=live-homepage

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

515. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=homepage-layout-clean

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/?elementor_library=home-with-delivery-tracker
https://libertybudsnyc.com/?elementor_library=live-homepage
https://libertybudsnyc.com/?elementor_library=live-homepage
https://libertybudsnyc.com/?elementor_library=live-homepage
https://libertybudsnyc.com/?elementor_library=homepage-layout-clean


516. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=homepage-layout-clean

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

517. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=homepage-layout-clean

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

518. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

519. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

520. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/?elementor_library=homepage-layout-clean
https://libertybudsnyc.com/?elementor_library=homepage-layout-clean
https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025
https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025
https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025


521. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=about-us-page

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

522. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=about-us-page

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

523. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=about-us-page

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

524. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025-2

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

525. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025-2

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/?elementor_library=about-us-page
https://libertybudsnyc.com/?elementor_library=about-us-page
https://libertybudsnyc.com/?elementor_library=about-us-page
https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025-2
https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025-2


526. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025-2

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

527. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-page-9-30-2025

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

528. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-page-9-30-2025

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

529. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=delivery-page-9-30-2025

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

530. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-footer-3745

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025-2
https://libertybudsnyc.com/?elementor_library=delivery-page-9-30-2025
https://libertybudsnyc.com/?elementor_library=delivery-page-9-30-2025
https://libertybudsnyc.com/?elementor_library=delivery-page-9-30-2025
https://libertybudsnyc.com/?elementor_library=elementor-footer-3745


531. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-footer-3745

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

532. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-footer-3745

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

533. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-footer-5231

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

534. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-footer-5231

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

535. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-footer-5231

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/?elementor_library=elementor-footer-3745
https://libertybudsnyc.com/?elementor_library=elementor-footer-3745
https://libertybudsnyc.com/?elementor_library=elementor-footer-5231
https://libertybudsnyc.com/?elementor_library=elementor-footer-5231
https://libertybudsnyc.com/?elementor_library=elementor-footer-5231


536. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=lb-lp-home

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

537. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=lb-lp-home

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

538. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=lb-lp-home

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

539. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=420-home

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

540. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=420-home

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/?elementor_library=lb-lp-home
https://libertybudsnyc.com/?elementor_library=lb-lp-home
https://libertybudsnyc.com/?elementor_library=lb-lp-home
https://libertybudsnyc.com/?elementor_library=420-home
https://libertybudsnyc.com/?elementor_library=420-home


541. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=420-home

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

542. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-header-5353

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

543. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-header-5353

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

544. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-header-5353

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

545. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-header-5402

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/?elementor_library=420-home
https://libertybudsnyc.com/?elementor_library=elementor-header-5353
https://libertybudsnyc.com/?elementor_library=elementor-header-5353
https://libertybudsnyc.com/?elementor_library=elementor-header-5353
https://libertybudsnyc.com/?elementor_library=elementor-header-5402


546. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-header-5402

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

547. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-header-5402

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

548. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=header-no-location

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

549. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=header-no-location

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

550. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=header-no-location

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/?elementor_library=elementor-header-5402
https://libertybudsnyc.com/?elementor_library=elementor-header-5402
https://libertybudsnyc.com/?elementor_library=header-no-location
https://libertybudsnyc.com/?elementor_library=header-no-location
https://libertybudsnyc.com/?elementor_library=header-no-location


551. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-header-4678

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

552. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-header-4678

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

553. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-header-4678

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

554. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=home-header

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

555. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=home-header

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/?elementor_library=elementor-header-4678
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556. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=home-header

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

557. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=header-old-queens

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

558. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=header-old-queens

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

559. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=header-old-queens

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

560. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=location-menu

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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561. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=location-menu

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

562. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=location-menu

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

563. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-footer-5006

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

564. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-footer-5006

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

565. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=elementor-footer-5006

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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566. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=default-kit

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

567. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=default-kit

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

568. 3 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/?elementor_library=default-kit

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

569. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/category/wellness/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

570. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/category/wellness/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/?elementor_library=default-kit
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571. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/category/wellness/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

572. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/category/events/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

573. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/category/events/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

574. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/category/events/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

575. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/category/education/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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576. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/category/education/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

577. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/category/education/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

578. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/category/product-reviews/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

579. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/category/product-reviews/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

580. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/category/product-reviews/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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581. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/category/lifestyle-culture/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

582. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/category/lifestyle-culture/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

583. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/category/lifestyle-culture/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

584. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/category/liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

585. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/category/liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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586. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/category/liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

587. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/category/uncategorized/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

588. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/category/uncategorized/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

589. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/category/uncategorized/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

590. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/upper-east-side/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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591. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/upper-east-side/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

592. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/upper-east-side/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

593. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/dispensary-culture/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

594. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/dispensary-culture/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

595. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/dispensary-culture/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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596. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-subway/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

597. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-subway/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

598. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-subway/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

599. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-commuting/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

600. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-commuting/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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601. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-commuting/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

602. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-lifestyle/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

603. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-lifestyle/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

604. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-lifestyle/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

605. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/legal-weed-nyc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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606. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/legal-weed-nyc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

607. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/legal-weed-nyc/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

608. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/edibles-nyc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

609. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/edibles-nyc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

610. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/edibles-nyc/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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611. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/best-albums-for-smoking-weed/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

612. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/best-albums-for-smoking-weed/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

613. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/best-albums-for-smoking-weed/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

614. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-music-pairings/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

615. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-music-pairings/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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616. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-music-pairings/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

617. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/weed-friendly-music/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

618. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/weed-friendly-music/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

619. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/weed-friendly-music/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

620. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/sesh-playlist/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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621. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/sesh-playlist/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

622. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/sesh-playlist/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

623. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/420-nyc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

624. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/420-nyc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

625. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/420-nyc/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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626. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-cannabis-events/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

627. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-cannabis-events/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

628. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-cannabis-events/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

629. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/manhattan-weed/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

630. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/manhattan-weed/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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631. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/manhattan-weed/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

632. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-dispensaries/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

633. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-dispensaries/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

634. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-dispensaries/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

635. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/miley-cyrus-weed-fashion/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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636. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/miley-cyrus-weed-fashion/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

637. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/miley-cyrus-weed-fashion/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

638. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/celebrity-cannabis-style/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

639. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/celebrity-cannabis-style/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

640. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/celebrity-cannabis-style/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/tag/miley-cyrus-weed-fashion/
https://libertybudsnyc.com/tag/miley-cyrus-weed-fashion/
https://libertybudsnyc.com/tag/celebrity-cannabis-style/
https://libertybudsnyc.com/tag/celebrity-cannabis-style/
https://libertybudsnyc.com/tag/celebrity-cannabis-style/


641. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/weed-culture-and-fashion/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

642. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/weed-culture-and-fashion/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

643. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/weed-culture-and-fashion/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

644. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/memorial-day/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

645. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/memorial-day/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/tag/weed-culture-and-fashion/
https://libertybudsnyc.com/tag/weed-culture-and-fashion/
https://libertybudsnyc.com/tag/weed-culture-and-fashion/
https://libertybudsnyc.com/tag/memorial-day/
https://libertybudsnyc.com/tag/memorial-day/


646. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/memorial-day/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

647. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/social-cannabis-use/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

648. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/social-cannabis-use/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

649. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/social-cannabis-use/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

650. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-bbq/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/tag/memorial-day/
https://libertybudsnyc.com/tag/social-cannabis-use/
https://libertybudsnyc.com/tag/social-cannabis-use/
https://libertybudsnyc.com/tag/social-cannabis-use/
https://libertybudsnyc.com/tag/cannabis-bbq/


651. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-bbq/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

652. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-bbq/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

653. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/manhattan-culture/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

654. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/manhattan-culture/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

655. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/manhattan-culture/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/tag/cannabis-bbq/
https://libertybudsnyc.com/tag/cannabis-bbq/
https://libertybudsnyc.com/tag/manhattan-culture/
https://libertybudsnyc.com/tag/manhattan-culture/
https://libertybudsnyc.com/tag/manhattan-culture/


656. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/museum-mile/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

657. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/museum-mile/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

658. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/museum-mile/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

659. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/legal-cannabis-nyc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

660. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/legal-cannabis-nyc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/tag/museum-mile/
https://libertybudsnyc.com/tag/museum-mile/
https://libertybudsnyc.com/tag/museum-mile/
https://libertybudsnyc.com/tag/legal-cannabis-nyc/
https://libertybudsnyc.com/tag/legal-cannabis-nyc/


661. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/legal-cannabis-nyc/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

662. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-and-art/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

663. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-and-art/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

664. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-and-art/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

665. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-and-food/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/tag/legal-cannabis-nyc/
https://libertybudsnyc.com/tag/cannabis-and-art/
https://libertybudsnyc.com/tag/cannabis-and-art/
https://libertybudsnyc.com/tag/cannabis-and-art/
https://libertybudsnyc.com/tag/cannabis-and-food/


666. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-and-food/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

667. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-and-food/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

668. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cinco-de-mayo/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

669. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cinco-de-mayo/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

670. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cinco-de-mayo/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/tag/cannabis-and-food/
https://libertybudsnyc.com/tag/cannabis-and-food/
https://libertybudsnyc.com/tag/cinco-de-mayo/
https://libertybudsnyc.com/tag/cinco-de-mayo/
https://libertybudsnyc.com/tag/cinco-de-mayo/


671. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-party-ideas/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

672. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-party-ideas/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

673. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-party-ideas/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

674. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-drinks/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

675. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-drinks/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/tag/cannabis-party-ideas/
https://libertybudsnyc.com/tag/cannabis-party-ideas/
https://libertybudsnyc.com/tag/cannabis-party-ideas/
https://libertybudsnyc.com/tag/cannabis-drinks/
https://libertybudsnyc.com/tag/cannabis-drinks/


676. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-drinks/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

677. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-beverages/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

678. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-beverages/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

679. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-beverages/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

680. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/tag/cannabis-drinks/
https://libertybudsnyc.com/tag/thc-beverages/
https://libertybudsnyc.com/tag/thc-beverages/
https://libertybudsnyc.com/tag/thc-beverages/
https://libertybudsnyc.com/tag/cannabis-edibles/


681. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

682. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-edibles/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

683. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-beverages/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

684. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-beverages/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

685. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-beverages/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/tag/cannabis-edibles/
https://libertybudsnyc.com/tag/cannabis-edibles/
https://libertybudsnyc.com/tag/cannabis-beverages/
https://libertybudsnyc.com/tag/cannabis-beverages/
https://libertybudsnyc.com/tag/cannabis-beverages/


686. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-label-guide/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

687. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-label-guide/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

688. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-label-guide/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

689. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-label/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

690. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-label/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/tag/thc-label-guide/
https://libertybudsnyc.com/tag/thc-label-guide/
https://libertybudsnyc.com/tag/thc-label-guide/
https://libertybudsnyc.com/tag/thc-label/
https://libertybudsnyc.com/tag/thc-label/


691. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-label/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

692. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-label/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

693. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-label/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

694. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-label/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

695. Title length 19 chars

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thcv/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "thcv | Liberty Buds"

https://libertybudsnyc.com/tag/thc-label/
https://libertybudsnyc.com/tag/cannabis-label/
https://libertybudsnyc.com/tag/cannabis-label/
https://libertybudsnyc.com/tag/cannabis-label/
https://libertybudsnyc.com/tag/thcv/


696. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thcv/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

697. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thcv/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

698. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thcv/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

699. Title length 18 chars

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbg/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "cbg | Liberty Buds"

700. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbg/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/tag/thcv/
https://libertybudsnyc.com/tag/thcv/
https://libertybudsnyc.com/tag/thcv/
https://libertybudsnyc.com/tag/cbg/
https://libertybudsnyc.com/tag/cbg/


701. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbg/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

702. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbg/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

703. Title length 18 chars

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cdc/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "cdc | Liberty Buds"

704. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cdc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

705. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cdc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/tag/cbg/
https://libertybudsnyc.com/tag/cbg/
https://libertybudsnyc.com/tag/cdc/
https://libertybudsnyc.com/tag/cdc/
https://libertybudsnyc.com/tag/cdc/


706. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cdc/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

707. Title length 18 chars

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbn/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "cbn | Liberty Buds"

708. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbn/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

709. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbn/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

710. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbn/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/tag/cdc/
https://libertybudsnyc.com/tag/cbn/
https://libertybudsnyc.com/tag/cbn/
https://libertybudsnyc.com/tag/cbn/
https://libertybudsnyc.com/tag/cbn/


711. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/live-resin/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

712. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/live-resin/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

713. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/live-resin/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

714. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/distillate/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

715. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/distillate/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/tag/live-resin/
https://libertybudsnyc.com/tag/live-resin/
https://libertybudsnyc.com/tag/live-resin/
https://libertybudsnyc.com/tag/distillate/
https://libertybudsnyc.com/tag/distillate/


716. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/distillate/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

717. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-oil/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

718. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-oil/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

719. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-oil/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

720. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-delivery-roosevelt-island/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/tag/distillate/
https://libertybudsnyc.com/tag/cannabis-oil/
https://libertybudsnyc.com/tag/cannabis-oil/
https://libertybudsnyc.com/tag/cannabis-oil/
https://libertybudsnyc.com/tag/cannabis-delivery-roosevelt-island/


721. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-delivery-roosevelt-island/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

722. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-delivery-roosevelt-island/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

723. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-cannabis-delivery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

724. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-cannabis-delivery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

725. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-cannabis-delivery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/tag/cannabis-delivery-roosevelt-island/
https://libertybudsnyc.com/tag/cannabis-delivery-roosevelt-island/
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726. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/roosevelt-island-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

727. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/roosevelt-island-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

728. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/roosevelt-island-dispensary/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

729. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-gifts/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

730. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-gifts/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/tag/roosevelt-island-dispensary/
https://libertybudsnyc.com/tag/roosevelt-island-dispensary/
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731. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-gifts/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

732. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/mothers-day/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

733. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/mothers-day/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

734. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/mothers-day/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

735. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/self-care/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/tag/cannabis-gifts/
https://libertybudsnyc.com/tag/mothers-day/
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736. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/self-care/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

737. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/self-care/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

738. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbd-for-anxiety/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

739. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbd-for-anxiety/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

740. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbd-for-anxiety/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/tag/self-care/
https://libertybudsnyc.com/tag/self-care/
https://libertybudsnyc.com/tag/cbd-for-anxiety/
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741. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-for-stress-relief/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

742. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-for-stress-relief/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

743. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-for-stress-relief/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

744. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/post-work-relaxation/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

745. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/post-work-relaxation/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/tag/cannabis-for-stress-relief/
https://libertybudsnyc.com/tag/cannabis-for-stress-relief/
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746. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/post-work-relaxation/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

747. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-unwind/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

748. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-unwind/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

749. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-unwind/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

750. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-sleep-aid/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/tag/post-work-relaxation/
https://libertybudsnyc.com/tag/thc-unwind/
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https://libertybudsnyc.com/tag/thc-unwind/
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751. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-sleep-aid/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

752. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-sleep-aid/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

753. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-for-sleep/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

754. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-for-sleep/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

755. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-for-sleep/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/tag/cannabis-sleep-aid/
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756. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-for-insomnia/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

757. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-for-insomnia/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

758. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-for-insomnia/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

759. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbd-for-sleep/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

760. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbd-for-sleep/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/tag/thc-for-insomnia/
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761. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbd-for-sleep/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

762. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-recovery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

763. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-recovery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

764. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-recovery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

765. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbd-for-fitness/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/tag/cbd-for-sleep/
https://libertybudsnyc.com/tag/thc-recovery/
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766. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbd-for-fitness/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

767. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cbd-for-fitness/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

768. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-for-athletes/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

769. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-for-athletes/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

770. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-for-athletes/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/tag/cbd-for-fitness/
https://libertybudsnyc.com/tag/cbd-for-fitness/
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771. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-and-exercise/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

772. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-and-exercise/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

773. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-and-exercise/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

774. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-gummies/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

775. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-gummies/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/tag/cannabis-and-exercise/
https://libertybudsnyc.com/tag/cannabis-and-exercise/
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776. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-gummies/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

777. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

778. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

779. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-edibles/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

780. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-chocolate/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/tag/cannabis-gummies/
https://libertybudsnyc.com/tag/nyc-edibles/
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781. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-chocolate/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

782. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/thc-chocolate/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

783. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/midtown-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

784. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/midtown-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

785. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/midtown-dispensary/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/tag/thc-chocolate/
https://libertybudsnyc.com/tag/thc-chocolate/
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786. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/prerolls/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

787. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/prerolls/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

788. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/prerolls/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

789. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

790. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://libertybudsnyc.com/tag/prerolls/
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791. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

792. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/behind-the-counter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

793. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/behind-the-counter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

794. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/behind-the-counter/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

795. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/dispensary-operations/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://libertybudsnyc.com/tag/nyc-cannabis/
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796. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/dispensary-operations/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

797. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/dispensary-operations/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

798. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/budtender-life/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

799. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/budtender-life/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

800. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/budtender-life/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://libertybudsnyc.com/tag/dispensary-operations/
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801. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-education/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

802. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-education/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

803. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-education/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

804. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/upper-east-side-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

805. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/upper-east-side-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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806. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/upper-east-side-cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

807. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

808. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

809. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/nyc-dispensary/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

810. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/upper-east-side-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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811. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/upper-east-side-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

812. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/upper-east-side-dispensary/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

813. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/liberty-buds-nyc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

814. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/liberty-buds-nyc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

815. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/liberty-buds-nyc/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.
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816. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/liberty-buds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

817. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/liberty-buds/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

818. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/liberty-buds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

819. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-community/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

820. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-community/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.
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821. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/cannabis-community/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

822. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/pop-up-event/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

823. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/pop-up-event/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

824. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/pop-up-event/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

825. Missing OpenGraph metadata

Severity: P3

Page URL: https://libertybudsnyc.com/tag/one-year-anniversary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.
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826. Missing Twitter card

Severity: P3

Page URL: https://libertybudsnyc.com/tag/one-year-anniversary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

827. 1 image(s) missing alt text

Severity: P3

Page URL: https://libertybudsnyc.com/tag/one-year-anniversary/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

828. Heavy JS payload (mobile): 457KB

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier3.weight.js-mobile

Detail

JavaScript transfer exceeds 250KB budget.

829. Heavy page weight (mobile): 16697KB

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier3.weight.total-mobile

Detail

Total transfer exceeds 2500KB budget.

830. Heavy JS payload (desktop): 457KB

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier3.weight.js-desktop

Detail

JavaScript transfer exceeds 250KB budget.
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831. Heavy page weight (desktop): 19150KB

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier3.weight.total-desktop

Detail

Total transfer exceeds 2500KB budget.

832. Missing security header: x-content-type-options

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier5.header.x-content-type-options

Detail

x-content-type-options not present on homepage response. Affects fortress score and CSP posture.

833. Missing security header: referrer-policy

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier5.header.referrer-policy

Detail

referrer-policy not present on homepage response. Affects fortress score and CSP posture.

834. Missing security header: permissions-policy

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier5.header.permissions-policy

Detail

permissions-policy not present on homepage response. Affects fortress score and CSP posture.

835. SSL Labs grade: unknown

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier5.fortress.ssl-grade

Detail

Qualys SSL Labs: SSL Labs HTTP 400. Aim for A+ via strong TLS 1.3, HSTS, CAA, and preload.
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836. DNSSEC not enabled

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier5.fortress.dnssec-missing

Detail

DNSSEC adds cryptographic verification to DNS responses. Consider enabling via your registrar.

837. No CAA DNS records

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier5.fortress.caa-missing

Detail

CAA records restrict which CAs may issue certs for your domain, preventing rogue issuance. Add CAA for

letsencrypt.org / digicert.com / etc.

838. DMARC policy is p=none (monitoring only)

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier5.fortress.dmarc-weak

Detail

DMARC published at p=none — monitoring mode only. After 2-4 weeks of clean reports, tighten to p=quarantine

→ p=reject.

839. Lighthouse a11y (mobile): 83/100

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier8.lighthouse.a11y-mobile

Detail

Score 83 is below target 95. See HTML report for details.

840. LH mobile: Preconnect to required origins (Est savings of 340 ms)

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier8.lh-opportunity.uses-rel-preconnect-mobile

Detail

https://libertybudsnyc.com/
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Consider adding preconnect  or dns-prefetch  resource hints to establish early connections to

important third-party origins. https://developer.chrome.com/docs/lighthouse/performance/uses-rel-

preconnect/" target="_blank" rel="noreferrer">Learn how to preconnect to required origins.

841. LH mobile: Preload Largest Contentful Paint image

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier8.lh-opportunity.prioritize-lcp-image-mobile

Detail

If the LCP element is dynamically added to the page, you should preload the image in order to improve LCP.

https://web.dev/articles/optimize-lcp#optimize_when_the_resource_is_discovered" target="_blank"

rel="noreferrer">Learn more about preloading LCP elements.

842. LH mobile: Defer offscreen images (Est savings of 905 KiB)

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier8.lh-opportunity.offscreen-images-mobile

Detail

Consider lazy-loading offscreen and hidden images after all critical resources have finished loading to lower

time to interactive. https://developer.chrome.com/docs/lighthouse/performance/offscreen-images/"

target="_blank" rel="noreferrer">Learn how to defer offscreen images.

843. LH mobile: Eliminate render-blocking resources (Est savings of

430 ms)

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier8.lh-opportunity.render-blocking-resources-mobile

Detail

Resources are blocking the first paint of your page. Consider delivering critical JS/CSS inline and deferring all

non-critical JS/styles. https://developer.chrome.com/docs/lighthouse/performance/render-blocking-resources/"

target="_blank" rel="noreferrer">Learn how to eliminate render-blocking resources.

844. LH mobile: Minify JavaScript (Est savings of 5 KiB)

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier8.lh-opportunity.unminified-javascript-mobile

Detail

Minifying JavaScript files can reduce payload sizes and script parse time.

https://developer.chrome.com/docs/lighthouse/performance/unminified-javascript/" target="_blank"
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rel="noreferrer">Learn how to minify JavaScript.

845. Lighthouse a11y (desktop): 83/100

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier8.lighthouse.a11y-desktop

Detail

Score 83 is below target 95. See HTML report for details.

846. LH desktop: Preconnect to required origins (Est savings of 120 ms)

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier8.lh-opportunity.uses-rel-preconnect-desktop

Detail

Consider adding preconnect  or dns-prefetch  resource hints to establish early connections to

important third-party origins. https://developer.chrome.com/docs/lighthouse/performance/uses-rel-

preconnect/" target="_blank" rel="noreferrer">Learn how to preconnect to required origins.

847. LH desktop: Defer offscreen images (Est savings of 602 KiB)

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier8.lh-opportunity.offscreen-images-desktop

Detail

Consider lazy-loading offscreen and hidden images after all critical resources have finished loading to lower

time to interactive. https://developer.chrome.com/docs/lighthouse/performance/offscreen-images/"

target="_blank" rel="noreferrer">Learn how to defer offscreen images.

848. LH desktop: Minify JavaScript (Est savings of 5 KiB)

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier8.lh-opportunity.unminified-javascript-desktop

Detail

Minifying JavaScript files can reduce payload sizes and script parse time.

https://developer.chrome.com/docs/lighthouse/performance/unminified-javascript/" target="_blank"

rel="noreferrer">Learn how to minify JavaScript.

849. LH desktop: Reduce unused JavaScript (Est savings of 265 KiB)
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Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier8.lh-opportunity.unused-javascript-desktop

Detail

Reduce unused JavaScript and defer loading scripts until they are required to decrease bytes consumed by

network activity. https://developer.chrome.com/docs/lighthouse/performance/unused-javascript/"

target="_blank" rel="noreferrer">Learn how to reduce unused JavaScript.

850. LH desktop: Serve images in next-gen formats (Est savings of

2,115 KiB)

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier8.lh-opportunity.modern-image-formats-desktop

Detail

Image formats like WebP and AVIF often provide better compression than PNG or JPEG, which means faster

downloads and less data consumption. https://developer.chrome.com/docs/lighthouse/performance/uses-webp-

images/" target="_blank" rel="noreferrer">Learn more about modern image formats.

851. A11y: ARIA role should be appropriate for the element

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier9.a11y.aria-allowed-role

Detail

Ensure role attribute has an appropriate value for the element

Impact: minor

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/aria-allowed-role?application=playwright

852. Dutchie menu iframe not found on /, /menu, or /shop

Severity: P3

Page URL: https://libertybudsnyc.com/

Rule: tier-revenue.dutchie.iframe-absent

Detail

No Dutchie iframe detected. If this client uses a different menu provider, add it to clients.yaml dutchieSlug=null

+ we'll stop flagging.
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Findings by Page

Grouped by URL — useful when working through the site one page at a time.

https://libertybudsnyc.com/

_48 findings on this page_

[P1] Lighthouse bestPractices (desktop): 59/100

[P1] A11y: Elements must only use supported ARIA attributes 🔴  DO FIRST

Your website has a navigation menu link that uses ARIA attributes (aria-expanded, aria-controls, aria-haspopup)

that aren't allowed on standard anchor tags. ARIA attributes are special instructions fo

[P1] A11y: ARIA dialog and alertdialog nodes should have an accessible name

[P1] A11y: Elements must meet minimum color contrast ratio thresholds (×2) 🟠  HIGH

Two location-name buttons on your homepage have black text (#000000) on a dark green background

(#347c3c), creating a contrast ratio of 4.09:1. WCAG accessibility standards require at least 4.5:1 cont

[P1] A11y: Links must have discernible text 🔴  DO FIRST

A link on your homepage has no visible or hidden text label. Screen readers—software that reads pages aloud

for blind and low-vision visitors—cannot announce what the link does. In this case, it's a n

[P1] webkit has 1 JS error(s) not present in Chromium 🟠  HIGH

Your site is attempting to load a third-party frame (i.liadm.com) in a way that violates browser security rules in

Safari and other WebKit browsers. This frame is blocked because the origin (the combi

[P2] 1 broken internal link(s)

[P2] Layout shift (mobile): 0.117

[P2] Missing core schema types: LocalBusiness

[P2] Missing security header: strict-transport-security

[P2] Missing security header: x-frame-options

[P2] Missing security header: content-security-policy

[P2] 88 tap targets under 44px at mobile-320

[P2] 90 tap targets under 44px at mobile-375

[P2] 90 tap targets under 44px at mobile-414

[P2] 77 tap targets under 44px at tablet-768

[P2] Lighthouse perf (mobile): 65/100

[P2] Lighthouse bestPractices (mobile): 61/100

[P2] Lighthouse perf (desktop): 75/100

[P2] A11y: Heading levels should only increase by one

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

[P3] Heavy JS payload (mobile): 457KB

[P3] Heavy page weight (mobile): 16697KB

[P3] Heavy JS payload (desktop): 457KB

https://libertybudsnyc.com/


[P3] Heavy page weight (desktop): 19150KB

[P3] Missing security header: x-content-type-options

[P3] Missing security header: referrer-policy

[P3] Missing security header: permissions-policy

[P3] SSL Labs grade: unknown

[P3] DNSSEC not enabled

[P3] No CAA DNS records

[P3] DMARC policy is p=none (monitoring only)

[P3] Lighthouse a11y (mobile): 83/100

[P3] LH mobile: Preconnect to required origins (Est savings of 340 ms)

[P3] LH mobile: Preload Largest Contentful Paint image

[P3] LH mobile: Defer offscreen images (Est savings of 905 KiB)

[P3] LH mobile: Eliminate render-blocking resources (Est savings of 430 ms)

[P3] LH mobile: Minify JavaScript (Est savings of 5 KiB)

[P3] Lighthouse a11y (desktop): 83/100

[P3] LH desktop: Preconnect to required origins (Est savings of 120 ms)

[P3] LH desktop: Defer offscreen images (Est savings of 602 KiB)

[P3] LH desktop: Minify JavaScript (Est savings of 5 KiB)

[P3] LH desktop: Reduce unused JavaScript (Est savings of 265 KiB)

[P3] LH desktop: Serve images in next-gen formats (Est savings of 2,115 KiB)

[P3] A11y: ARIA role should be appropriate for the element

[P3] Dutchie menu iframe not found on /, /menu, or /shop

https://libertybudsnyc.com/best-edibles-in-nyc/

_5 findings on this page_

[P3] Title length 84 chars

[P3] Description length 188 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/thcv/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your tag page for 'thcv' doesn't have a meta description—a 160-character summary that appears in Google

search results below the page title. Without it, Google generates a random snippet from your pag

[P3] Title length 19 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/best-edibles-in-nyc/
https://libertybudsnyc.com/tag/thcv/


https://libertybudsnyc.com/tag/cbg/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Meta descriptions are the short text snippets that appear below your page title in Google search results.

Without one, Google will auto-generate something from your page content, which is often awkwar

[P3] Title length 18 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cdc/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your tag archive page for 'cdc' has no meta description — the short text that appears below your site name in

Google search results. Without it, Google may auto-generate one from your page content, wh

[P3] Title length 18 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cbn/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for "cbn" doesn't have a meta description — the 160-character summary that appears below your

page title in Google search results. Without it, Google will auto-generate one from your pag

[P3] Title length 18 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/breaking-myths-debunking-common-

misconceptions-about-cannabis/

_4 findings on this page_

[P3] Title length 77 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text
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https://libertybudsnyc.com/breaking-myths-debunking-common-

misconceptions-about-cannabis-2/

_4 findings on this page_

[P3] Title length 77 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/get-spooky-with-dank-at-liberty-buds-

halloween-pre-roll-celebration/

_4 findings on this page_

[P3] Title length 85 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/celebrities-who-use-cannabis/

_4 findings on this page_

[P3] Title length 74 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/upper-east-side-dispensary-things-to-do/

_4 findings on this page_

[P3] Title length 91 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/riding-subway-high-upper-east-side-cannabis-

dispensary/

_4 findings on this page_

[P3] Title length 132 chars
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/category/events/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your Events category page is missing a meta description — the 155-character text snippet that appears below

your page title in Google search results. Without it, Google generates a random excerpt from

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/category/education/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your /category/education/ page is missing a meta description — the 155-character summary that appears under

your page title in Google search results. Without it, Google may auto-generate one from your

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/category/product-reviews/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your product reviews category page doesn't have a meta description—the 155-character summary that appears

below your page title in Google search results. Without it, Google generates a random snippet

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/category/lifestyle-culture/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

https://libertybudsnyc.com/category/events/
https://libertybudsnyc.com/category/education/
https://libertybudsnyc.com/category/product-reviews/
https://libertybudsnyc.com/category/lifestyle-culture/


This archive page (a collection of blog posts about lifestyle and culture) has no meta description — the 155-

character summary that appears below your page title in Google search results. Without it,

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/category/liberty-buds/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your category archive page (Liberty Buds news/blog section) is missing a meta description—the 160-character

summary that appears under your site name in Google search results. Without it, Google gener

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/category/uncategorized/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your category archive page (Uncategorized) doesn't have a meta description — the 160-character summary

that appears below your page title in Google search results. Without it, Google generates a gener

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/upper-east-side/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your tag page for 'upper-east-side' is missing a meta description — the 160-character text snippet that appears

under your link in Google search results. Without it, Google generates a random excerpt

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/dispensary-culture/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

https://libertybudsnyc.com/category/liberty-buds/
https://libertybudsnyc.com/category/uncategorized/
https://libertybudsnyc.com/tag/upper-east-side/
https://libertybudsnyc.com/tag/dispensary-culture/


Search engines like Google use meta descriptions—a 155-character summary of a page—to decide what text

appears under your link in search results. Without one, Google generates its own from page conten

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/nyc-subway/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This tag page (one that groups content about 'NYC subway') has no meta description — the 2–3 sentence

summary that appears under your page title in Google search results. Without it, Google generates

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-commuting/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag archive page for 'cannabis-commuting' doesn't have a meta description — the 50–160 character

summary that appears below your page title in Google search results. Without it, Google generates

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-lifestyle/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

This page doesn't have a meta description—the 155-character summary that appears below your page title in

Google search results. Without it, Google generates one automatically, which is often choppy o

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/legal-weed-nyc/

_4 findings on this page_

[P2] Missing meta description

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://libertybudsnyc.com/tag/nyc-subway/
https://libertybudsnyc.com/tag/cannabis-commuting/
https://libertybudsnyc.com/tag/cannabis-lifestyle/
https://libertybudsnyc.com/tag/legal-weed-nyc/


[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/edibles-nyc/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'edibles-nyc' is missing a meta description — the 155-character summary that appears below

your page title in Google search results. Without it, Google generates its own snippet from

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/best-albums-for-smoking-weed/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'best-albums-for-smoking-weed' has no meta description — that's the 155-character

summary that appears below your link in Google search results. Without it, Google auto-generates a s

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-music-pairings/

_4 findings on this page_

[P2] Missing meta description

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/weed-friendly-music/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This tag page has no meta description — the 155-character summary that appears below your URL in Google

search results. Without it, Google shows a random snippet from the page, which often looks broke

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/sesh-playlist/

https://libertybudsnyc.com/tag/edibles-nyc/
https://libertybudsnyc.com/tag/best-albums-for-smoking-weed/
https://libertybudsnyc.com/tag/cannabis-music-pairings/
https://libertybudsnyc.com/tag/weed-friendly-music/
https://libertybudsnyc.com/tag/sesh-playlist/


_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'sesh-playlist' is missing a meta description — the 2–3 sentence summary that appears below

your page title in Google search results. Without it, Google generates a random excerpt fr

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/420-nyc/

_4 findings on this page_

[P2] Missing meta description

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/nyc-cannabis-events/

_4 findings on this page_

[P2] Missing meta description

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/manhattan-weed/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your tag archive page for 'manhattan-weed' doesn't have a meta description—the 150-160 character summary

that appears under your site name in Google search results. Without it, Google generates a rand

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/nyc-dispensaries/

_4 findings on this page_

[P2] Missing meta description

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/420-nyc/
https://libertybudsnyc.com/tag/nyc-cannabis-events/
https://libertybudsnyc.com/tag/manhattan-weed/
https://libertybudsnyc.com/tag/nyc-dispensaries/


https://libertybudsnyc.com/tag/miley-cyrus-weed-fashion/

_4 findings on this page_

[P2] Missing meta description

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/celebrity-cannabis-style/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This page has no meta description — the 155-character snippet that appears below your page title in Google

search results. Without it, Google generates a random excerpt from your page content, which o

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/weed-culture-and-fashion/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'weed-culture-and-fashion' is missing a meta description — the 150-160 character summary

that appears under your page title in Google search results. Without it, Google generates a r

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/memorial-day/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'memorial-day' is missing a meta description — a 155–160 character snippet that appears

below your page title in Google search results. Without it, Google will auto-generate text fro

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/social-cannabis-use/

_4 findings on this page_

https://libertybudsnyc.com/tag/miley-cyrus-weed-fashion/
https://libertybudsnyc.com/tag/celebrity-cannabis-style/
https://libertybudsnyc.com/tag/weed-culture-and-fashion/
https://libertybudsnyc.com/tag/memorial-day/
https://libertybudsnyc.com/tag/social-cannabis-use/


[P2] Missing meta description

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-bbq/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Meta descriptions are the short text summaries that appear below your page title in Google search results. This

tag/archive page is missing that summary, so search results will show auto-generated tex

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/manhattan-culture/

_4 findings on this page_

[P2] Missing meta description

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/museum-mile/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Search engines use meta descriptions (the 50–160 character summary under your page title in Google results)

to help people decide whether to click your link. When a page lacks one, Google generates a

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/legal-cannabis-nyc/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This tag archive page (/tag/legal-cannabis-nyc/) is missing a meta description — the 150–160 character

summary that appears below your page title in Google search results. Without it, Google generates

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-bbq/
https://libertybudsnyc.com/tag/manhattan-culture/
https://libertybudsnyc.com/tag/museum-mile/
https://libertybudsnyc.com/tag/legal-cannabis-nyc/


https://libertybudsnyc.com/tag/cannabis-and-art/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'cannabis-and-art' doesn't have a meta description — the 50-160 character summary that

appears under your page title in Google search results. Without it, Google generates a random s

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-and-food/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'cannabis-and-food' doesn't have a meta description — the 50-160 character summary that

appears under your site link in Google search results. Without it, Google generates a random s

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cinco-de-mayo/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

This page has no meta description — the 160-character text that appears below your page title in search

results. Without it, Google shows a random snippet from your page content, which is often poorly

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-party-ideas/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

This tag archive page is missing a meta description—a short text summary that appears below your page title in

search results. Without it, search engines show a random snippet from your page, making i

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-drinks/

https://libertybudsnyc.com/tag/cannabis-and-art/
https://libertybudsnyc.com/tag/cannabis-and-food/
https://libertybudsnyc.com/tag/cinco-de-mayo/
https://libertybudsnyc.com/tag/cannabis-party-ideas/
https://libertybudsnyc.com/tag/cannabis-drinks/


_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'cannabis-drinks' doesn't have a meta description — the 50–160 character summary that

appears below your page title in Google search results. Search engines generate a default snippe

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/thc-beverages/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

This tag page (/tag/thc-beverages/) has no meta description — the 155-character summary that appears below

your site title in Google search results. When Google can't find one, it generates a random s

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-edibles/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your tag page for 'cannabis-edibles' is missing a meta description — the 50–160 character summary that

appears below your page title in Google search results. Without it, search engines write their ow

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-beverages/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'cannabis-beverages' is missing a meta description — the 50–160 character summary that

appears under your site name in Google search results. Without it, Google generates a random sn

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/thc-label-guide/

_4 findings on this page_

https://libertybudsnyc.com/tag/thc-beverages/
https://libertybudsnyc.com/tag/cannabis-edibles/
https://libertybudsnyc.com/tag/cannabis-beverages/
https://libertybudsnyc.com/tag/thc-label-guide/


[P2] Missing meta description 🟠  HIGH

This page has no meta description—the 155-character summary that appears below your page title in Google

search results. Without one, Google generates a random excerpt from your page, which often look

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/thc-label/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'thc-label' doesn't have a meta description — the 50–160 character summary that appears

below your page title in Google search results. Without it, Google generates a random snippet

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-label/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'cannabis-label' doesn't have a meta description — that's the 50-160 character summary that

appears below your page title in Google search results. Without it, Google may auto-genera

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/live-resin/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'live-resin' doesn't have a meta description — that's the 2-3 sentence summary Google shows

under your page title in search results. Without it, Google auto-generates a snippet that

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/distillate/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

https://libertybudsnyc.com/tag/thc-label/
https://libertybudsnyc.com/tag/cannabis-label/
https://libertybudsnyc.com/tag/live-resin/
https://libertybudsnyc.com/tag/distillate/


Your tag archive page for 'distillate' is missing a meta description—the 50–160 character summary that appears

under your site name in Google search results. Without one, Google will auto-generate a s

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-oil/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

This tag page has no meta description—the 155-character summary that appears below your page title in

Google search results. Without it, Google generates a random snippet from your page content, which

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-delivery-roosevelt-island/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your tag page for 'cannabis-delivery-roosevelt-island' is missing a meta description — the 155-character

snippet that appears below your page title in Google search results. Without it, Google generat

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/nyc-cannabis-delivery/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your tag page for 'nyc-cannabis-delivery' doesn't have a meta description — the 160-character summary that

appears under your page title in Google search results. Without it, Google generates a random

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/roosevelt-island-dispensary/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

https://libertybudsnyc.com/tag/cannabis-oil/
https://libertybudsnyc.com/tag/cannabis-delivery-roosevelt-island/
https://libertybudsnyc.com/tag/nyc-cannabis-delivery/
https://libertybudsnyc.com/tag/roosevelt-island-dispensary/


This tag archive page doesn't have a meta description — the 155-character summary that appears under your

page title in Google search results. Without it, Google generates a random snippet from your p

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-gifts/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

This tag page (for 'cannabis-gifts') doesn't have a meta description — the 50–160 character summary that

appears below your page title in Google search results. Without it, Google generates a random s

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/mothers-day/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'mothers-day' is missing a meta description — the 50-160 character summary that appears

below your page title in Google search results. Without it, Google may auto-generate a snippet

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/self-care/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your tag page for 'self-care' doesn't have a meta description — that's the 2–3 sentence summary that appears

under your page title in Google search results. Without it, Google generates one automatica

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cbd-for-anxiety/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

https://libertybudsnyc.com/tag/cannabis-gifts/
https://libertybudsnyc.com/tag/mothers-day/
https://libertybudsnyc.com/tag/self-care/
https://libertybudsnyc.com/tag/cbd-for-anxiety/


Your tag page for 'CBD for anxiety' has no meta description—the short text snippet that appears under your

page title in Google search results. Without it, Google generates a random excerpt from your

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-for-stress-relief/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

This archive page about 'cannabis for stress relief' has no meta description — the 50–160 character summary

that appears below your page title in Google search results. Without it, Google generates a

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/post-work-relaxation/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Search results on Google show a brief text snippet under your page title — that's the meta description. This tag

page is missing that snippet, so Google will auto-generate one from your page text, whi

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/thc-unwind/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page (for 'thc-unwind') doesn't have a meta description—the 50-160 character summary that appears

below your page title in Google search results. Without one, Google generates a random excerp

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-sleep-aid/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

https://libertybudsnyc.com/tag/cannabis-for-stress-relief/
https://libertybudsnyc.com/tag/post-work-relaxation/
https://libertybudsnyc.com/tag/thc-unwind/
https://libertybudsnyc.com/tag/cannabis-sleep-aid/


This page is missing a meta description — the short text (usually 150–160 characters) that appears below your

page title in Google search results. Without it, Google will auto-generate a snippet from

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/cannabis-for-sleep/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

This tag page doesn't have a meta description — the 160-character summary that appears under your page title

in Google search results. Without it, Google generates random text from your page, which of

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/tag/thc-for-insomnia/

_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your tag page for 'THC for Insomnia' doesn't have a meta description—the short text snippet (usually 150–160

characters) that appears below your page title in Google search results. Without it, Google
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This tag archive page (for 'thc-recovery') doesn't have a meta description — the short text snippet that appears

below your site name in Google search results. Without it, Google may auto-generate a s
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https://libertybudsnyc.com/tag/liberty-buds-nyc/
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/choosing-the-right-edible-for-you/

_3 findings on this page_
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/valentines-day-karaoke-night/
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https://libertybudsnyc.com/kiva-confections-at-liberty-buds/
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https://libertybudsnyc.com/join-us-for-4-20/
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/best-cannabis-music-pairings-liberty-buds/

_3 findings on this page_
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/miley-cyrus-weed-fashion-liberty-buds/
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/cannabis-for-cinco-de-mayo/

_3 findings on this page_

[P3] Missing OpenGraph metadata
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/cannabis-for-mothers-day/

_3 findings on this page_
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[P3] 1 image(s) missing alt text
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https://libertybudsnyc.com/weed-shop-near-me-liberty-buds-midtown-

east/
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https://libertybudsnyc.com/edibles-brands-changing-the-cannabis-game/
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https://libertybudsnyc.com/1-year-anniversary-at-liberty-buds/
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https://libertybudsnyc.com/cannabis-and-creativity/
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https://libertybudsnyc.com/upper-east-side-cannabis-culture/
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[P3] 1 image(s) missing alt text
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https://libertybudsnyc.com/cozy-autumn-strains-liberty-buds/

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/cannabis-infused-fall-recipes-nyc/
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[P3] 1 image(s) missing alt text
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/liberty-buds-strains-october/
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/autumn-cannabis-flavors-liberty-buds/
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[P3] Missing OpenGraph metadata
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/happy-effect-cannabis-products-liberty-buds/
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https://libertybudsnyc.com/fall-cannabis-recipes-liberty-buds/
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/fall-wine-and-weed-pairings/
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[P3] Missing OpenGraph metadata
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/beat-the-fall-slump-with-cannabis/
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/top-hybrid-picks-for-the-weekend/
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/ayrloom-fall-favorites/
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[P3] 1 image(s) missing alt text
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https://libertybudsnyc.com/bouket-premium-flower-fall/
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[P3] 1 image(s) missing alt text

https://libertybudsnyc.com/specials/
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[P3] Missing OpenGraph metadata
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[P3] 2 image(s) missing alt text

https://libertybudsnyc.com/cannabis-dispensary-midtown-east/
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https://libertybudsnyc.com/cannabis-dispensary-murray-hill/
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https://libertybudsnyc.com/cannabis-dispensary-upper-east-side/
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https://libertybudsnyc.com/press/
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[P3] 1 image(s) missing alt text
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Seven images on your About page lack alternative text (alt text)—short descriptions that screen readers

announce to visitors with visual impairments, and that search engines use to understand image co
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[P2] 9 image(s) missing alt text 🟠  HIGH

Nine images on your Queens/Nassau dispensary page don't have descriptive alt text — text that appears if the

image fails to load and that screen readers read aloud to visually impaired visitors. This
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https://libertybudsnyc.com/cannabis-dispensary-queens-nassau/
https://libertybudsnyc.com/?elementor_library=elementor-loop-item
https://libertybudsnyc.com/?elementor_library=internal-page-template
https://libertybudsnyc.com/?elementor_library=elementor-single-page-3883
https://libertybudsnyc.com/?elementor_library=elementor-single-page-3883
https://libertybudsnyc.com/?elementor_library=elementor-single-post-3884
https://libertybudsnyc.com/?elementor_library=elementor-single-post-3884


[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=updated-homepage

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=home

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=sliders

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=home-with-sliders

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=lb-home

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=lb-slider

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=updated-homepage
https://libertybudsnyc.com/?elementor_library=home
https://libertybudsnyc.com/?elementor_library=sliders
https://libertybudsnyc.com/?elementor_library=home-with-sliders
https://libertybudsnyc.com/?elementor_library=lb-home
https://libertybudsnyc.com/?elementor_library=lb-slider


https://libertybudsnyc.com/?elementor_library=delivery-checker

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=skyline-bgs

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=delivery-homepage

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=lb-video-homepage

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=home-with-delivery-

tracker

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=live-homepage

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=delivery-checker
https://libertybudsnyc.com/?elementor_library=skyline-bgs
https://libertybudsnyc.com/?elementor_library=delivery-homepage
https://libertybudsnyc.com/?elementor_library=lb-video-homepage
https://libertybudsnyc.com/?elementor_library=home-with-delivery-tracker
https://libertybudsnyc.com/?elementor_library=home-with-delivery-tracker
https://libertybudsnyc.com/?elementor_library=live-homepage


https://libertybudsnyc.com/?elementor_library=homepage-layout-clean

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=about-us-page

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025-

2

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=delivery-page-9-30-2025

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=elementor-footer-3745

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=homepage-layout-clean
https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025
https://libertybudsnyc.com/?elementor_library=about-us-page
https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025-2
https://libertybudsnyc.com/?elementor_library=delivery-page-8-29-2025-2
https://libertybudsnyc.com/?elementor_library=delivery-page-9-30-2025
https://libertybudsnyc.com/?elementor_library=elementor-footer-3745


https://libertybudsnyc.com/?elementor_library=elementor-footer-5231

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=lb-lp-home

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=420-home

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=elementor-header-5353

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=elementor-header-5402

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=header-no-location

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=elementor-footer-5231
https://libertybudsnyc.com/?elementor_library=lb-lp-home
https://libertybudsnyc.com/?elementor_library=420-home
https://libertybudsnyc.com/?elementor_library=elementor-header-5353
https://libertybudsnyc.com/?elementor_library=elementor-header-5402
https://libertybudsnyc.com/?elementor_library=header-no-location


https://libertybudsnyc.com/?elementor_library=elementor-header-4678

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=home-header

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=header-old-queens

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=location-menu

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=elementor-footer-5006

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=default-kit

_3 findings on this page_

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://libertybudsnyc.com/?elementor_library=elementor-header-4678
https://libertybudsnyc.com/?elementor_library=home-header
https://libertybudsnyc.com/?elementor_library=header-old-queens
https://libertybudsnyc.com/?elementor_library=location-menu
https://libertybudsnyc.com/?elementor_library=elementor-footer-5006
https://libertybudsnyc.com/?elementor_library=default-kit


https://libertybudsnyc.com/robots.txt

_1 finding on this page_

[P3] robots.txt does not reference sitemap

https://libertybudsnyc.com/wp-login.php

_1 finding on this page_

[P0] Sensitive artifact exposed: /wp-login.php 🔴  DO FIRST

Your WordPress login page (/wp-login.php) is publicly accessible and returns a 200 status code, meaning

anyone on the internet can find and attempt to access it. This is a standard WordPress path that
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